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RELEASE NOTES

Version Date Notes
3.05 Jul. 02, 2015 » Modified: 2.2.1 File Menu — Open WDM/Save As WDM commands
added
3.04 Jun. 29, 2015 > Modified: 1.5.2 Backlight — descriptions for particular LCD
backlight setting added for 8600
3.03 Aug. 22, 2014 » Modified: 1.5.1 Download Method — FastVPort interface added
for AG8600 added
3.02 Jun. 30, 2014 » Modified: 1.5.5 Font File — LATIN (Multilingual Latin 1), SLAVIC
(Latin 1), POLISH (Central European, Latin Il), Latin | (CP_1252)
languages added
» Modified: 1.5.5 Font File — Latin(Slovak) & Windows 1250 fonts
are not supported for 8600 series
3.01 May 05, 2014 » Modified: 1.5.5 Font File — Turkish (CP-1254) language added
> Modified: Appendix Il — add ‘Code 39 Security Level’, ‘EANS8
GTIN-13 format’ (the Symbology Settings table)
> Modified: Appendix Il — add GS1 Formatting (for GS1-128, GS1
DataBar Family) (the Symbolog Settings table)
> Modified: Appendix Il1l1 — add ‘Code 39 Security Level’, ‘EANS
GTIN-13 format’ in the Symbology Settings Table (8700)
> Modified: Appendix IV — add ‘Read Redundancy’, ‘Mobile Display
Mode’ in the Reader Settings Table
> Modified: Appendix IV — TLC-39 default changed to ‘Disable’,

GS1 Formatting/Field Separator/Application ID mark added for
GS1 DataBar and Composite CC-A/B/C in the Symbology Settings
Table
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2.16

2.15
2.14

Dec. 12, 2013

Jan. 28, 2013

Dec. 14, 2011
May 17, 2011
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Modified: Introduction — Download WLAN AG Runtime table
updated (8590/8700 removed; 8630 added)

Modified: Introduction — Getting Started — AG Program table
updated (8590/8700 removed; 8630 added)

Modified: 1.1 Form — screenshot updated
Modified: 1.1.1 Name — (form 1 — 10 for 8600 only)
Modified: 1.1.2 Font — updated for 8600
Modified: 1.1.3 ESC — form 1 —~ 5 (form 1 — 10 for 8600 only)
Modified: 1.1.4 Next — form 1 —~ 5 (form 1 — 10 for 8600 only)
Modified: 1.1.11 Input Source — Bluetooth added (8600 only)
Modified: 1.2 Menu — Menu tab screenshot updated
New: 1.2.2 Color Properties (8600 only)
Modified: 1.2.5 Next — form 1 ~ 5 (form 1 — 10 for 8600 only)
Modified: 1.5.1 Download Method - AG8600 added
Modified: 1.5.4 Wi-Fi Security - *802.11b/g/n for 8600
*8600 supports WPA2

Modified: 1.6 Startup - Startup tab screenshot updated
New: 1.6.5 Startup Color Properties
New: 1.6.6 Error Message Color properties
Modified: Chapter 2 Wireless Database Manager —

*add 8630 to wireless connectivity list

*remove 8590 from wireless connectivity list

Modified: Appendix | Scan Engine Settings — reader table
updated

Modified: Appendix 1l CCD/LASER Scan Engine — updated for
8600

Modified: Appendix 1V 2D Scan Engine — tables updated for
8600

Modified: “1.1 Form” — screenshot updated

Modified: “1.1.2 Font” — Font table updated

New: “1.1.6 Record” added

Modified: “1.1.8 Data Type” — Passdown option added
Modified: “1.2 Menu” — screenshot updated

Modified: “1.4 Barcode” — screenshot updated
Modified: “1.5 Settings” — screenshot updated

New: “1.5.5 Font File” added

New: “Appendix 11l LR/ZELR LASER SCAN ENGINE” -
Symbology Settings Table (8700) added

New: 8700 support
Modified: Appendix IV — Change MSI to “Disable” by default



2.13

2.12

2.11

2.10

2.09

2.08

2.07

2.06

2.05

2.04

Mar. 21, 2011

Dec. 02, 2010

Jun. 04, 2010

Nov. 19, 2009

July 29, 2009

June 25, 2009

June 10, 2009

Jan 16, 2009

July 30, 2008

Jun. 26, 2008
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New: support 8200

Modified: Appendix | — Support Code 11 for Long Range Laser
(8300 only)

Modified: Appendix I~Il — Support UPC-E1 for CCD/Laser (8200
only)

Modified: Appendix I—I11 — Support Coop 25 for CCD/Laser (8200
only)

Modified: Appendix Il — Add Aiming Duration for CCD/Laser (8200
only)

Modified: Appendix 11l — Add Scan Mode options and Time-out for
Long Range Laser (8300 only)

Modified: Appendix Il — Support Code 11 for Long Range Laser
(8300 only)

Modified: Appendix IV — Add Aiming Duration for 2D (8200 only)

Modified: Appendix IV — Change Codabar, Code 93 and MSI to
“Enable” by default

Modified: Appendix IV — Support GS1-128 Emulation Mode setting
for Composite Codes (8200 only)

New: System Requirements
Modified: 1.5.4 Wi-Fi Security — WEP key

Modified: 1.5.4 Wi-Fi Security — input accepts ASCII instead of
hex values

Modified: Appendix I—-1V — add more GS1 DataBar symbologies
Modified: 1.4 Barcode — update screenshot

Modified: 2.2.1 File Menu — Preferences

Modified: Appendix I1—1V — update default values

Modified: Appendix IV 2D Scan Engine — add Continuous and
Alternate Modes

New: support 8400-2D

Modified: Appendix IV — Chinese 25, Matrix 25, Picklist Mode, 1D
Inverse, 2D Inverse, UPU FICS Postal and USPS 4CB/One Code/
Intelligent Mail

Modified: Update all screenshots

Modified: Introduction — Change the installation method from
Power suite CD to Product CD

Modified: Appendix IlI—I1ll support replacement of GS1-128 field
separator for all scan engines

Modified: 1.5.3 IP — Add “Enable DHCP”
Modified: Descriptions for “Settings” Page are added.

Modified: Change barcode prompt RSS to GS1 Databar and
EAN-128 to GS1-128

Modified: Descriptions and features available for 8400 are added

Modified: Appendix IlI—I1l support replacement of EAN-128 field
separator for all scan engines
Modified: 1.4.1 RFID Reader — Automatically enabled after

initialization (checkbox removed from Ul)

New: Long Range Laser option available for 8300
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2.02
2.01

2.00

1.05
1.04

1.03

Nov. 06, 2007

Oct. 18, 2007
Sep. 20, 2007

Sep. 10, 2007

June 20, 2006
Apr. 14, 2006

Apr. 10, 2006

»
»
»
»

Modified: 1.4.1 Reader Type — RFID tags in proximity will be read
automatically by 8300/8500 when RFID reader is enabled

Modified: Features

New: AG8300 for 8330

Modified: 1.1.4 Next — RFID for 8300 Series as well
Modified: 1.1.9 Input Source — RFID for 8300 Series as well

New Word template applied

»

v v Vv WV

Merge documentation of WLAN Application Generator and Wireless
Database Manager

Modified: 5.3 Barcode & Parameters
Modified: 1.2.2 — Font_12x12 not supported
Modified: 5.1 & 5.2.6

RF AG for CPT-8500 is included
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INTRODUCTION

Easy-to-use and quick-to-apply, FORGE WLAN Application Generator for
8000/8200/8300/8400/8500/8600/8700 Series Mobile Computers is designed for users
to develop custom templates that run with the AG runtime preloaded on the mobile
computers. Users are able to define their own data collection templates on any desktop
computer without spending time writing any program code.

FORGE WLAN Application Generator is used to develop applications for many purposes,
such as —

Receiving in Retail

Price Check

Product labeling & Tracking
Shelf Product Replenishment
Mobile Point of Sale (POS)
Mobile Inventory Management
Order Picking & Staging
Work-In-Process Tracking
Material Flow Control
Transportation & Distribution
Warehousing

VvV VvV VvV VvV VvV VvV VvV VvV VvV VvV v v

Asset Management

FORGE WLAN Application Generator presents itself as a graphic image of the mobile
computer. It simulates the program’s running sequences on the actual mobile computer,
and allows you to design a new application template on your personal computer in
minutes. Send the application template file you have designed to the mobile computer so
it can commence immediately when the mobile computer starts up.

Two options are provided for the host computer to receive data from the mobile
computer in a real-time way — data saved as a text file or directly updated to the
database.

This manual provides comprehensive knowledge of FORGE WLAN Application Generator
for 8000/8200/8300/8400/8500/8600/8700 Series Mobile Computers to help you define
custom templates for certain data collecting applications. We recommend that you read
the document thoroughly before use and keep it at hand for quick reference.

Thank you for choosing CipherLab products!
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SYSTEM REQUIREMENTS

To run the program, one of the Windows operating system is required:

v Vv v Vv

Windows 2000
Windows XP
Windows Vista
Windows 7

FEATURES

v VvV VvV VvV VvV VvV VvV VvV v v

Definition of program flow

Editing of screens and data

Managing barcode reader and RFID reader

Font size options and program localization

Simple program simulation for debugging

Password-protected user settings to prevent unauthorized user intervention
Hot key selection for tasks or user settings’ menus

Definition of system initial settings for a quick start

Easy cloning by downloading the template file

Real-time data collection via Wireless Database Manager
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DOWNLOAD WLAN AG RUNTIME

Data collection mainly involves three actions: input (scanning or key-in), data processing,
and output (or updating database). FORGE WLAN Application Generator for
8000/8200/8300/8400/8500/8600/8700 Series Mobile Computers is designed to perform
data processing inside the mobile computers.

If your mobile computer is not pre-loaded with the WLAN AG runtime program (.SHX),
you must transfer a copy of the WLAN AG runtime and your desired font file (.SHX) to
the mobile computer via the “Program Load” utility.

On the mobile computer, press [7] + [9] + [Power] simultaneously to enter System
Menu | Load Program.

Shortcut Name of Utility AG Runtime Program Applied to

Program Load WU8071.SHX 8071

(= ProgLoad.exe) WU8200.SHX 8230
WU8300.SHX 8330, 8370
WU8400.SHX 8470
WU8500.SHX 8570
WU8600.SHX 8630
WU8700.SHX 8770, 8790



FORGE WLAN Application Generator User Guide

GETTING STARTED

Run the AG program (AG8*.exe) from the Product CD or copy it to your PC. The

graphical image of a certain mobile computer model pops up.

Shortcut Name of AG Program AG Program Applied to
AG8000 for WLAN AG8071WLAN.exe 8071
AG8200 for WLAN AG8200WLAN.exe 8230
AG8300 for WLAN AG8300WLAN.exe 8330, 8370
AG8400 for WLAN AG8400WLAN.exe 8470
AG8500 for WLAN AG8500WLAN.exe 8570
AG8600 for WLAN AG8600WLAN.exe 8630
AG8700 for WLAN AG8700WLAN.exe 8770, 8790

Right-click anywhere on the image or click on the [Power] button on the image.

The Command Menu appears as shown below.

» Click Edit to start with a new or the latest application template, and upon

completion, click OK to close the editing window.

» Click Save or Save As to save the current edited template to a file (*.ATF).

» Click Preferences to configure the download settings.

» Click Download Application to download the template file (*.ATF) to the mobile

computer.

1.Take data

i el e

ciprer[E

Qpen.. . ! Ll ]

/' [3oEF)

! /Gnno)

Save Chrl+5
Save As...

Edit Zkrl+-E
Preferences. ..

Dovenload Application

About, .,
Exit olt+F4

2) Turn on the mobile computer to run the AG runtime program, WU8*.SHX.

On the mobile computer, configure the download settings that are consistent with the
configuration on the PC side. Take 8000 Series WLAN AG Runtime menu for example:



3)

4)

5)

6)

Introduction

» Select 2. Utilities Menu | 6. Download Port
» Select 2. Utilities Menu | 7. Baud Rate

On the mobile computer, select 2. Utilities Menu | 8. Load Application to
download the template file. After downloading, the main menu displays.

On the mobile computer, select 2. Utilities Menu | 2. TCPIP Settings. Configure
effective TCP/IP settings to connect to the specified host computer in a real-time way.

Run Wireless Database Manager on your computer for real-time data collection via
802.11b/g (802.11b/g/n for 8600).

If no lookup files are defined on both the Form and Lookup property pages, you may
receive data from the mobile computer over the wireless network via the “WLAN

Read” utility.

Program Applied to
Wireless Database Manager.exe All series
WLAN_Read.exe All series

On the mobile computer, select 1. Take Data to connect to your computer and start
with the data collection task.
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COMMAND MENU

For the first time, the Command Menu appears with commands as the picture shown
below.

CIpEm. .. ! Chrl+0

Save Chel+5
Save As...

Edit Ztrl+E
Preferences. .,

Download Application

About. .
Exit Alt+F4
Command Action...
New To create a new application template.
Open To open an existing application template. File path needs to be specified.
Save To save the current editing template.
Save As To save the current editing template to a new file.
Edit To edit a new or the latest application template.
Preferences To configure the COM port and language settings.
Download Application To download the current application template to the mobile computer.
About... To show information about the WLAN Application Generator.
Exit To close the WLAN Application Generator.



RECENT FILE LIST

Introduction

If you ever saved a template, it will be displayed on the Command Menu as well. Up to 4

recent template files are listed for quick access.

Mew Chrl-+1
CIpEM. .. Chrl+0
Save Chrl+5
Save As...

Edit Ckrl+E
Preferences. ..

Download Application

2: Di\AG_4.ATF % |

31 Di\AG_3.ATF
4: Di\AG_2.ATF

Recent File List

Abouk, .,
Exit

Alt+F4

» The first file on the recent file list is the latest template you work on. If you
accidentally clicked the Close button or OK of the template, simply click the Edit
command to re-open it.

» You may click any of the four files to open the template for editing. It will then be
placed on top of the list.
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PREFERENCES

To send the application template customized in the FORGE WLAN AG to the mobile
computer, right-click anywhere on the user’s interface of the AG or click the power
button on the user’s interface to display the Command Menu; select “Preference” from
the Command Menu to see the [AG8**** WLAN Preferences] dialogue box as the picture
shown below:

AGB0X1 WLAN Preferences x|

Diownload wia Cradle-|R

COM poart (1~ 255] : 1 =i

Baud rate : I'I'IEEEIEI bps "I

[T Auto-preload the lazt editing file.

[T Abways on top.

Language :

| D efault <Englishs =l

Ok 13 Cancel |

In this Preference dialogue box, make the following settings:

» Download Settings

Specify the details of the download interface such as the COM port and baud rate.
Refer to Startup property page for communication time-out.

Warning: The download settings on the host computer and the mobile computer
must be consistent; otherwise, the downloading will fail.

» Auto-preload the last editing file.

Select “Auto-preload the last editing file” to have the FORGE WLAN AG load the last
edited template file as soon as it is run.

> Always on top.

Select “Always on top” to have the FORGE WLAN AG remain on the top of all other
windows on Windows desktop.

» Language

If there is any language file (*.Ing) saved into the folder where FORGE WLAN AG’s
executable file locates, language options will become available. You will be able to
select a preferred language for the GUI of the program. Further details please refer to
Localization.
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LOCALIZATION

If you want to customize the entire application for your local language, you must
translate the text used in the user interface into your own language, as well as re-define
menus and messages for the runtime.

)

2)

3)

4)

3)

On your PC, run the utility “Program Load” to send your desired font file (.SHX) to the
mobile computer.

On the mobile computer, press [7] + [9] + [Power] simultaneously to enter System
Menu | Load Program.

On your PC, go to the folder where FORGE WLAN AG’s executable file locates. In the
folder, save the existing language file (*.Ing) as a new one. Translate the text
contained in the new file to your local language.

On your PC, run FORGE WLAN AG. Right-click anywhere on the graphical image of the
FORGE WLAN AG or simply click the [Power] button on the graphical image of the
FORGE WLAN AG. Command Menu displays. Click Preferences from the Command
Menu to display [Preferences] dialog box. Under “Language” label, select the new
language file that you just created.

From the Command Menu of the FORGE WLAN AG, select “Edit” to re-define the
prompts and messages on the Startup property page of the application template.

» For double-byte languages such as Japanese and Chinese, font size selection on
the Form and Menu property pages (except 8500 Series) should be set to “large”
to display contents properly on the LCD screen. However, the rest of prompts and
messages can only be displayed in alphanumeric characters in the current system.

Click Download Application to send the template file (*.ATF) to the mobile
computer.

Turn on the mobile computer to run the AG runtime program, WU8*.SHX.

Select 2. Utilities Menu | 8. Load Application to download the template file.



FORGE WLAN Application Generator User Guide

PROGRAM SIMULATION

When you complete the entire configuration, send the application template file (*.ATF) to
the mobile computer. However, you may run program simulation beforehand to verify if
the program sequences meet your requirements.

Take Data

Main Menu

= Application Generator - [ New file ]

Utilities

Only partial simulation is allowed. TCP/IP settings on the mobile computer must be configured
correctly; otherwise, it will fail to connect to the specified computer (Server), and you will not be
allowed to take any data! Refer to Startup property page for communication time-out.

2.Utilities

|

[1-Reader Test

10



Chapter 1
WLAN APPLICATION GENERATOR

To work on a new or existing application template, click New, Open, or Edit from the
Command Menu. An application template is composed of six tabbed pages for your
configuration of the application template. They are:

i Application Generator - [ New file ] i

Form |I'u'|enu | Lookup | Earcndel Settings | Startupl

Property Pages

Form Forms are used to show information and collect data, which may be placed under a user
menu, e.g. 1. Take Data | (Menu 1) | Form 1.

Menu Menus are used to provide multi-level options, which may be placed under the main
menu, e.g. 1. Take Data | Menu 1 | (Menu 2) | Form 1.

Lookup Lookup property page enables you to define the data structure of up to 3 lookup files.
Barcode You may configure symbologies and barcode parameters.

Settings You may configure the mobile computer's Download Method, Backlight, IP and Wi-Fi
Security from PC side.

Startup You may configure program sequences and customize user interface on the mobile
computer.

Warning: On the Barcode tab, you must select the correct barcode reader even
though no modification is made to its settings. Otherwise, it will indicate
"wrong reader type" after downloading the template file to the mobile
computer and cause the reader to fail!

11
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1.1 FORM

A “form” means a data collecting form with multiple input fields. Data is transferred to a
host computer in a real-time way when all the input fields (lines) of a form are completed.
The data will be added to the lookup database or saved as transaction records.

» Each form allows at most eight input fields (8 lines), or 12 input fields (12 lines) for
8600 only.

» Five different forms can be defined (10 for 8600).

The attributes on this property page are explained in detail as follows.

Application Generator - [ Mew file ]

Farm ]Menu I Lookup] Barcodel Settings] Staltupl

1 name: ’ﬁzhc: Mainmen| O Lookup file : |1stlookupfile ﬂ Color Properties
I Background : | Black  ~
Font size : |small [10x200 4 Mexst: |f0rm1 6 |Recod: |update lookup j
2 Foreground:: | it
Fant file - 7 Mo match action : |insert tar lookup file j -
Line Data type Prampt Input zource Min length  Max lenagth Lookup Properties
#1 [(=F14 9 ] | 10 |b0lh 11 |E| 12 |5E| 13 nil 14 mare, . 15
92 [ | | | I | | =] 8 more ]
43 [ni = | | = | | =l
#a i =l | | | | | ! =] o |
#5 [ | | | ] | | ! =] [moe |
#5 |l x| | | =i | | []
47 [ni =l | . | ! =l e |
4 | =] | | = | | =]
13 [ni ~ | | = | | =l
#10 [ -] | | ] | ! =] [moe |
#11 i =l | | ] | ! =] e |
wafa =l | e I o T
Feset 16
ak. | Caticel

12



1.1.1 NAME

Chapter 1 WLAN Application Generator

Select the form you are going to set up. “form 1” is usually the form to start with.

» form 1~ 5 (form 1 — 10 for 8600 only)

1.1.2 FONT

Click the Font Size drop-down menu to select between small and large options. Large
font must be applied to double-byte languages, such as Chinese and Japanese. On the
Form and Menu property pages, font size needs to be changed accordingly. Refer to
Localization and 1.2.1 Font.

Font File is a read-only text field displaying the language you have specified on the
Settings tab page. Refer to 1.5.5 Font File.

Mobile Computer

Small (Font 6x8)

Large (Font 8x16)

8000 Series
8300 Series

Mobile Computer

16 characters by 8 lines (default)
20 characters by 8 lines (default)

Small (Font 10x20)

12 characters by 4 lines

15 characters by 4 lines

Large (Font 12x24)

8600 Series

Single-byte
Double-byte

Mobile Computer

24 characters by 12 lines (default)
12 characters by 12 lines (default)

Small Font (8x16, 16x16)

20 characters by 12 lines

10 characters by 12 lines

Large Font (12x16, 10x20, 20x20)

8200 Series

8400 Series

8500 Series

8700 Series

Single-byte

Double-byte

Single-byte

Double-byte

Single-byte

Double-byte

Single-byte

Double-byte

20 characters by 8 lines (8x16)
20 characters by 8 lines (8x16)
10 characters by 8 lines (16x16)
20 characters by 8 lines (8x16)
20 characters by 8 lines (8x16)
10 characters by 8 lines (16x16)
20 characters by 8 lines (8x16)
20 characters by 8 lines (8x16)
10 characters by 8 lines (16x16)
20 characters by 8 lines (8x16)
20 characters by 8 lines (8x16)
10 characters by 8 lines (16x16)

13 characters by 8 lines (12x16)
16 characters by 7 lines (10x20)
8 characters by 7 lines (20x20)
13 characters by 8 lines (12x16)
16 characters by 7 lines (10x20)
8 characters by 7 lines (20x20)

N/A

13 characters by 8 lines (12x16)

16 characters by 7 lines (10x20)
8 characters by 7 lines (20x20)

13
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Note: “Font Size” drop-down menu isn’t available for 8500 Series which can only display
information in small font size.

1.1.3ESC

Select a form or menu that displays when the [ESC] key is pressed to the currently
edited form when it runs on the mobile computer later. For settings of the user menu,
refer to the Menu property page.

» Main Menu
» form 1~ 5 (form 1 — 10 for 8600 only)
» user menu

Note: Normally, the [ESC] key is used to return to a previous form or menu.

1.1.4 NEXT

Select a form or menu that displays when all the input fields of the currently edited form
are completed when it runs on the mobile computer later. For settings of the user menu,
refer to the Menu property page.

» Main Menu

» form 1~ 5 (form 1 — 10 for 8600 only)

> user menu

This action is triggered by sending the key value of [Enter] when you finish with the last

input field of a form. And, the setting of 1.1.11 Input Source decides the way to produce
the key value of [Enter].

Input Source of the last line Operation

Reader Auto ENTER (="Scan + ENTER”) for barcode input must be
enabled. Refer to 1.1.15 Properties.

Keypad Press the [Enter] key on the
8000/8200/8300/8400/8500/8600/8700 Series mobile
computer.

Both See the two options above.

RFID Press the [Enter] key on the 8300/8500/8600/8700 Series
mobile computer.

All See all the options above.

1.1.5 LOOKUP FILE

A lookup file is a database. Select if the currently edited form should refer to a lookup file.
If a lookup file is selected, the information about its data structure needs to be provided

to the Lookup property page.

14
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On Lookup property page, related settings must be configured.

) See section 1.1.9 Data Type
» See section 1.1.14 Lookup (Field)

Note: The associated lookup file(s) must be opened in the Wireless Database Manager. If
no lookup file is in use, you can collect data directly via the “WLAN Read” utility
(WLAN_Read.exe).

1.1.6 RECORD

Options in the Record drop-down menu determine the action to take when all the input
fields of a form is completed. The options may vary depending on whether a lookup file is
designated in the “Lookup file” drop-down menu.

Options Action

Update lookup | Updates the lookup file associated with the form (a lookup file designated).
Pass down Passes down the data to the next form or menu without saving.

Save Save the data to the .txt file (no lookup file referred).

1.1.7 NO MATCH ACTION

When a form is set to refer to a lookup file, the form must have one input field associated
with the key field of the database (lookup file). Refer to 1.3.7 Key Field. Choose the
appropriate action to take when the input data does not match that of the key field.

Insert to Lookup File

The program will proceed to the next input field without showing any message. Such new data will
be inserted to the lookup file.

Show Warning Message

The program will suspend and prompt a warning message. You will need to clear the input data
manually (that is, 9990, in the example below).

Product Code:9990
Description:

Bin:

Quantity:

pata not found!

Press any kKey...

Insert & Show Warning

The program will suspend and prompt a warning message. Then it will resume allowing data input
and insert it to the lookup file.

15
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1.1.8 COLOR PROPERTIES (8600 ONLY)

Click the drop-down menus to determine background & foreground colors of the form for
8600 mobile computer.

1.1.9 DATATYPE

A data collecting form generally consists of a series of input fields that are arranged line
after line in a data collecting form. To set up an input field, you need to configure its
property, which usually covers a variety of elements to be configured. “Data Type” is one
of these elements that needs your configuration.

The following table gives an account of the “Data Types” available and how each data
type interacts with other elements in an input field. A check mark means an selection
that is available:

Data Type Prompt Input Source Length Lookup Properties
on-screen Min / Max Field More...

nil

text v v v v v

integer v v v v v

real v v v v v

letter v v v v v

boolean 4 v 4 4

lookup 4 4 v

prompt v

extension

pause v

passdown 4

Warning: Data type of each field defined in the Form and Lookup property pages

must match.

In the following contents of this section, you will be guided through the available “Data
Types”:

Nil

No data input is allowed.

> This is the default setting. Set the data type of an input field to “Nil” to have a blank line on
the screen of the mobile computer.

Text

16
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Set the data type of an input field to “Text” to accept only ASCII characters. Any ASCII character
is acceptable. For example, $1a2b3c=-*/..

> If a lookup field is specified, the input value will overwrite the lookup value.

Integer

Set the data type of an input field to “Integer” to accept only whole numbers. Any whole number
is acceptable suchas ... -2, -1, 0, 1, 2 ..

> When integer is selected for the data type of an input field and a lookup file is assigned, the
input field will first apply the value in the assigned lookup field. Then you can either press
Enter key to accept the data or input other data manually.

> By setting the data type of an input field to “Integer”, the configuration of another element
“Lookup” will become available. The following are three examples that show the arithmetic
operations to be performed to the lookup value referred to when positive, negative or no
arithmetic sign at all is selected for the “Lookup” element.

Product Code:9950
Description:Coke
Bin:Al1lBO1

Quantity:EOOO

Product Code:9950
Description:Coke
Bin:Al1lBO1

Quantity:[oo00

Product Code: 9950
Description:Coke
Bin:Al1BO1

Quantity:[ooo0

Lookup field : field (no sign)
If input value is 5,

the value saved in transaction record is 5,
and the value saved to lookup file is 5 too.

Lookup field : +field

If input value is 5,

the value saved in transaction record is +35,

and the value saved to lookup file is 4005.

Lookup field : -field

If input value is 5,
the value saved in transaction record is -5,
and the value saved to lookup file is 3995.

Lookup (field) Real-time Data Collection via Wireless Database Manager

field 1 ~ 8 The input value will overwrite the lookup value. No arithmetic operations are
performed.

+ field 1 ~ 8 The input value will be added to the lookup value automatically.

- field1~8 The input value will be deducted from the lookup value automatically.

Real

Set the data type of an input field to “real number” to accept any number with a decimal
representation whether rational or irrational. For example, 4.56

» If a lookup field is specified, the input value will overwrite the lookup value.

Letter

17
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Set the data type of an input field to “Letter” to accept only alphabetic characters. Any letter is
acceptable, capital or small (Aa ~ Zz).

> If a lookup field is specified, the input value will overwrite the lookup value.

Boolean

Only one of these sets of values are acceptable — “0 or 1”7, “Y or N” and “T or F”.

» If a lookup field is specified, the input value will overwrite the lookup value.

> If you input a value other than the above ones, a message will be displayed on the mobile
computer to indicate "Data type is wrong!"

Lookup

No data input is allowed.

» If a lookup field is specified, the input value will overwrite the lookup value.
» When data of a previous input field is found matching with the "key field" of a lookup file, data
of this input field will be imported from its associated lookup field. Refer to 1.3.7 Key Field.

Note: The lookup value is imported for reference. No change is allowed.

Prompt

No data input is allowed.

> The prompt string will not be saved.

Extension

No data input is allowed.

> The line needs to be reserved as an "extension" of the previous line so the whole input data
can be displayed on the mobile computer screen.

Note: The number of extension lines depends on the maximum length of your data and
the screen size of the mobile computer.

Take the following for example —
If the screen of the mobile computer allows 20 characters per line for small font,

» Now the prompt string ("Description :" in line 2) takes 13 characters, and the data length is 15
characters at most.

This makes the total length 28 characters at most, which is longer than one line.

As a result, the data type of line 3 needs to be set "extension" if you want to display the input
data in full.

18
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13 15
Line  Dataltype Prompt Input source  Min lengthl Max length| Variables  Properties

#1 |text Ll |Descriplion: ||:u:.lh ﬂ l1 l15 |ni| j me_.,l
#2 |exlensiu:-n LI I Ij‘,r.."r'. j ][‘ |:§-|j| |_,-=;. LI

i~

more

v
Description :1234567]) 20-13=7
890ABCDE 15

*Xen

SaUTT 8§

Max. 20 characters

Pause

No data input is allowed.

> The prompt string will not be saved. However, it will be highlighted constantly on the mobile
computer to catch your attention.

Passdown

With “Passdown” set as data type, the input field won’t allow users to enter data. It only imports
the data collected by the previous form whose Record drop-down menu is set to “Passdown”.

» When one single line isn’t enough to display the imported data, the input field needs one or
more input fields succeeding it set to “Extension”.

1.1.10 PROMPT

“Prompt” is yet another element that needs your configuration for an input field. Specify
a prompt string for a specific input field, if necessary.

1.1.11 INPUT SOURCE

Specify the source that data should be collected from.

» Reader

> Keypad

» Both

» RFID (only applicable to 8300, 8500, 8600, 8700 Series)
» Bluetooth (only applicable to 8600)

> All (only applicable to 8300, 8500, 8600, 8700 Series)

Upon the completion of one input field, it is necessary to press the [Enter] key on the
mobile computer. Then the cursor will move either to the next input field, or to the next

form or menu.
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When the input source is specified to “reader” only, you need to enable "Auto ENTER" for
barcode input settings. Refer to 1.1.15 Properties.

Note: When “RFID” is selected, you may still press the [ESC] or [Enter] key on the
mobile computer to cancel or confirm a task. The other keys on the keypad won’t
work.

1.1.12 MINIMUM LENGTH

Specify the minimum length of the input data.

» If the input data is shorter than specified, it is considered unacceptable.

1.1.13 MAXIMUM LENGTH

Specify the maximum length of the input data. The value can be 50 at most.

» If the input data is longer than specified, it is considered unacceptable.

Input via Barcode/RFID Reader

For data input from the barcode or RFID reader, a warning message will display when the data is
too long.

Input via Keypad

For a data input from the keypad, it is allowed even if gets longer than the screen can display.
Take the scenario below for example.

» The screen of the mobile computer allows 20 characters per line for small font.

» Each prompt string takes 12 characters.
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Line | Input from Keypad Screen Reading Transaction Record

#1 12345678 12345678 12345678
1234567890 34567890 1234567890
1234567890ABCDE 3456789E 123456789E

#3, 4 1234567890A 123456789A 123456789A

#5, 6 1234567890LEMONADE 1234567890LEMOE 1234567890LEMOE

#7, 8 12345678900RANGE_JUICE ' 12345678900RANGE_JUICE | 12345678900RANGE_JUICE

line  Datatype Prompt Input source Minlength Mawlength  Lookup  Properties
#1 [ =] [Descipton [bath =] |1 19 [l =] moe |
#2 [ni =] | [bon =] [o E 2] mee ]
#3 [es ] [Descrption [botn x| |1 [10 i x| moe. |
#4 [extension =| | [bon ] [0 E [ = o |
#5 fiew ] [Desciption [boh =] [t [15 [l =] o |
#6 [extension =] | [t =] [0 [0 [ 2] more |
#7 [ed 7| [Deseiiption [boh =] i E i x| moe |
#8 [extension = | [botn =] [0 E [ = ooe

1.1.14 LOOKUP (FIELD)

Refer to section 1.1.5 Lookup File. If a lookup file is in use, you need to specify the
corresponding lookup field line by line. For each lookup file, there will be a key field.
Normally, the "key field" is Field #1. When an input field makes reference to the key field
and its input data is found matching, data for its following input fields will be imported
from each corresponding lookup fields.
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ril

field 1
field 2
field 3
field 4
field 5
field &
field 7
field B

field 2
field 3
-fiedd
Lookup Field for data types fieid| Lookup Field for data type
other than “integer” 1&5 “integer”

-fNe
field &
field 1 +held 1
field 2 +ield 2
field 3 +ield 3
field 4 +igld 4
field 5 +igld 5
field & +ield &
field 7 +igld 7
field & +field &

Note: When an arithmetic sign (+, -) is prefixed to the lookup field, the input data will be
added or subtracted from the lookup value.

1.1.15 PROPERTIES

Specify field properties if necessary.

x
Formn #1 Line #1
—Field data — Barcode input

[ Initial walue or kext [~ Read partial barcode

Start pozitian ; |1
b axirnurm length ; |2EI
[~ Check leading code I

v Auto EMTER

[~ &dd prefiz code

1]

[~ &dd suffi code

Cancel |
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Initial Value or Text

Select the check box. An initial value or text, up to 9 characters, specified here will be shown in the
input field. It is to be replaced by input data. For example, it can be used to prompt an initial value
for quantity.

Add Prefix Code

Select the check box to prefix a code to the input data. Type one or more codes. For example, a
dollar sign ("$") can be added to the front of the data input for price.

Add Suffix Code

Select the check box to suffix a code to the input data. Type one or more codes. Instead of using
delimiters in section 1.6.2 Data Field Delimiter, you may use prefix and/or suffix codes to separate
each entry of input data.

Note: You may use prefix/suffix code to wrap the input data.

Read Partial Barcode

By default, it will return the whole barcode that has been decoded. When the check box is selected,
it will return partial barcode according to the settings of the start position and maximum length.
Below are some examples.

Start position Max. length Barcode scanned Transaction record
2 10 9876543210 876543210
2 3 9876543210 876

Check Leading Code

The leading code refers to the digit in the start position of a barcode. Select the check box to verify
the barcode input. When the leading code is not matching, the barcode will be rejected. Below are
some examples.

Leading code Barcode scanned Transaction record
9 9876543210 9876543210
2 9876543210 (Error: code not matching)

Read partial code + Check leading code:

Start position Max. length Leading Code | Barcode scanned Transaction record
2 7 8 9876543210 8765432
2 7 9 987654321 (Error)

Auto ENTER

Normally, it is necessary to press the [Enter] key on the mobile computer upon completion of one
input field. Then, it will move either to the next input field, or to the next form/menu specified.
This function will automatically add a carriage return after the barcode input (="Scan + ENTER").
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Press this button to load the default settings.

Note: The current settings for all forms will be cleared.
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1.2 MENU

A menu is a list of selections that access various forms defined for the mobile computer
to perform. Only one user menu can be defined. The items on this tab are 12 for 8600
while 8 for conventional 8 series.

Application Generator - [ New file ]

Form  Menu ]Lnokupl Barcodel Settingsl Staltup]

Faont Size : small [10x20) - 3 |tenu Tite |
Fant File :

Color Properties 1 | | Main meru

2 Background : N Black  ~ ) | |Main enL
Foreground : Wwhie ¥ #3 | | Main menu

#4 | | ain menu

Itenn Ma. 4 | Item Mame 5 | Hest

H5 | | M ain meru

HE | | b air ey

#s | | b air meru

bt | | b air ey

#3 | | b air ey

#10 | |Main TMEL

#11 | |Main e

1 23 P P T P T I R

#12 | |Main e

6 Reset

]t

ak. Cancel
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Large font must be applied for double-byte languages, such as Chinese and Japanese. On
the Form and Menu property pages, font size needs to be changed accordingly (refer to
Localization and 1.1.2 Font). Font File is a read-only text field displaying the language
you have specified on the Settings tab page (refer to 1.5.5 Font File).

Click the drop-down menus to determine background & foreground colors of the menu for
8600 mobile computer.

Select the check box and specify a caption for the user menu if necessary.

Specify a name for each menu item. It allows up to eight menu items (12 items for 8600).
For example, you may specify "1. Goods In" or "Goods In" (see below) in the first field of
Item Name.

Note: Whether you have included Item No. in the name field, you can press [1] on the
mobile computer to enter the "Goods In" menu.

Caption

Item Name

Select a form or menu that will be displayed when a menu item has been selected.

» Main Menu
» form 1 ~ 5 (form 1 — 10 for 8600 only)
> none

Items 3 & 4 serve as
a fixed message
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Note: You may press the [ESC] key to return to the main menu.
If “none” is selected, the menu item will serve as a fixed message only.

This function can be invoked by performing one of the following actions on the mobile
computer —

» Press the shortcut key (Item No.) of a menu item, e.g. press [2] to select the second
menu item. The form or menu you specified here will be displayed then.

» Press the [Up/Down] arrow keys to select a menu item, and then press [Enter].

1.2.6 RESET
Click this button to load the default settings.

Note: The current settings for the user menu will be cleared.
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1.3 LOOKUP

A lookup file is a database file created for information reference. Up to three lookup files
can be defined.

If the lookup parameters are wrongly configured on the Lookup property page, the input
fields of a data collecting form may not be able to fetch the corresponding lookup value.

Other related settings:

» section 1.1.5 Lookup File

» section 1.1.9 Data Type (Lookup)

» section 1.1.14 Lookup (Field)

= Application Generator - [ New file ] 2 x|
Form I Menu  Lookup | Earcodel Settings | Startupl
1 |Mame: |[ESRWEEEE
4 5 6 7
3 |Numberof fields : [0 -] Field  Datatype Field name ax Length Key Tield
S B | 5
2 |Field
e 2 et | | [ &
{ Fixed length - Ite;e:t j I I -
& Delimiter |44 {ASCIN Ha |,[.3v.‘i j I I ~
s o | o«
8 Date stamp :  |nil - 78 Ite;::t j I I C
7 e | -
9 . il -
Time stamp :  |nil o Ite,'::t j I I -
Reset 10
ok | Cones
1.3.1 NAME

Select a lookup file you want to define. Up to 3 different lookup files are definable. The
“1st lookup file” is usually the file to start with.
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“Field Property” group box functions for users to provide the information about the ASCII
character or symbol that indicates the start or end of the data.

Fixed Length

If the lookup file referred to isn’t a field-delimited file, you need to specify the fixed length of each
data field. Proceed to define related settings on the right-hand side —

» Number of fields
» Data type

» Field name

> Length

Delimiter

This is the default setting. A delimiter (ASCII code) is used to separate the data fields.
Proceed to define related settings on the right-hand side —

» Number of fields

» Data type

» Field name

» Max. Length

It must at least cover the referred fields of the database (lookup file). Refer to 1.1.14
Lookup (Field).

Specify the data type for each lookup field.

> text

» integer
> real

> letter

» boolean

Specify a name for each lookup field.
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1.3.6 (MAX) LENGTH

Fixed Length

When the field property is set to Fixed Length, specify the length of each data field referred to.

Delimiter

When the field property is set to Delimiter, specify the maximum length of each data field referred
to.

Note: The maximum length of the input fields on the Form property page must be
specified accordingly.

1.3.7 KEY FIELD

The import of data depends on the key field. Select your key field so an index file can be
created for the database (lookup file).

» When a form makes reference to a lookup file, there must be one input field
associated with the key field of the database (lookup file). When the values of the
input data and the key field match, data of other input fields referring to a lookup
field will be imported accordingly.

If no matching, refer to the settings of 1.1.7 No Match Action.

1.3.8 DATE STAMP

It may be necessary to join the date information to the updated data records of
database.

» If the format starts with a "+", the date stamp will be added to the end of a record.

» If the format ends with a "+", the date stamp will be added to the beginning of a
record.

1.3.9 TIME STAMP

It may be necessary to join the time information to the updated data records of
database.

» If the format starts with a "+", the time stamp will be added to the end of a record.

» If the format ends with a "+", the time stamp will be added to the beginning of a
record.

1.3.10 RESET

Click this button to load the default settings.

Note: The current settings for all lookup files will be cleared.
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1.4 BARCODE

According to the requirements of a specific application, you may enable or disable any of
the barcode symbologies and configure the associated parameters. Supported barcodes
depend on the scan engine integrated with the mobile computer.

" Application Generator, - [ Mew file ]

Farm ] beru ] Lookup Barcode lSettings] Startup]
1 |Reader Type 2 | Reader Settings
Barcode Reader Szan mode |La$e[ j 4 | Roset to default
) Laser/CCD/LAL Reader Readedundancy:  |none |
RFID Setting [Decode Timeout ; |3_ B0
—
[ Megative Barcode
3 |Barcode & Parameters
¥ Code 33 mare... || [ UPCE mare.. | | T Telepen noe. |
™ Italian Phamacods J [~ UPCE Addon 2 ™ G5 Databar J
™ French Phamacods J [~ UPCE Addon 5 [ GS1 Databar Limited J
¥ Industrial 25 M v EANS M ~ GS1 DatabalEHpandedJ
v Interleaved 25 M [ E&ME Addon 2 [v Code 33
™ Malix 25 oo | T EANS AddonS W Code 128
W Codabar M W EANT3 & UPCA M v G51-128 M
™ Ms| J ™ EANT3 Addon 2 B (e 2 A
™ Plessey J ™ EAN13 Addon 5 W ISBT 128
’TI Cancel |
1.4.1 READER TYPE

Refer to Appendix | — Scan Engine Settings for details.

Barcode Reader

Click the drop-down menu to select a reader type that matches the hardware configuration of your
mobile computer. Then the associated barcode parameters will be displayed accordingly. If there is
a More button next to the barcode symbology listed, advanced settings are available.

Note: In order to initialize the barcode reader, you must select the correct reader type
when you first configure a template. Otherwise, a message will be displayed on
the mobile computer to indicate "Wrong reader type!" after you download the
template file.
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RFID Reader

The RFID reader is automatically enabled after initialization. You can click the RFID Setting button
to configure advanced settings as the figure shown below. RFID tags in proximity will be read
automatically by 8300/8500/8600/8700 when RFID reader is enabled. You may limit the Input
Source options in Form to prevent from misreading RFID data.

x

[¥ Read LID

[, FRead Data

% Start Piosition : I_
b awimunm Lenath . (127

[~ | Wse Delimiter I—

Read UID
By default, the RFID reader is set to read UID (Unique Identification).

Read Data

» Select the check box so RFID data can be read.

> If only partial data is required, specify the start position and maximum length.

User Delimiter

Select the check box and specify a delimiter to separate UID from data.
1.4.2 READER SETTINGS

Refer to the following appendices for information on barcode reader settings —

» Appendix Il — CCD/Laser Scan Engine for details.
» Appendix Il — LR/ELR Laser Scan Engine for details.
» Appendix IV — 2D Scan Engine for details.

1.4.3 BARCODE & PARAMETERS

Refer to the following appendices for information on symbology settings —

> Appendix Il — CCD/Laser Scan Engine for details.
» Appendix Il — LR/ELR Laser Scan Engine for details.
» Appendix IV — 2D Scan Engine for details.
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Click [Reset] to load the default settings. This applies to the following:

» section 1.4.1 Reader Type

» section 1.4.2 Reader Settings

» section 1.4.3 Barcode & Parameters

Note: The current settings will be cleared.
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1.5 SETTINGS

The [Settings] page allows you to configure terminal’s Download Method, Backlight, IP
and Wi-Fi Security from your PC.

Application Generator - [ New file ]

Farmn ] Menu ] Lu:u:ukup] Barcode  Settings ]Startup]
1 | Download Method 2 |Backight
Interface : {» Dizable " Enable
sadizie: 115200 bps 3 Tum backlight offif idle far ~ [2 [175) 10sec.
3 IP 4 Security
¥ Enable DHCP Authentication : " Share Key & Open System
Subnet Mazk | [~ E&P Identity :
Gateway - | Pagzzward : ,7
DMS Server - | [ WEP Key Length : | J Active
- =
Terminal 1P : | B |
Key 2 | i
Server [P | o.o0. 0.0
Ky 3: | f'“
Server Port - 1024 Key & | ~
e | [~ WPA [ WPAZ Passphrase : |
5 | FontFile
- 6 Reset
|Eng||sh j
ok | Cancel |
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Interface

Chapter 1 WLAN Application Generator

Select a transmission interface for the mobile computer to download data from your PC. The
following is a list that gives an account of the transmission interfaces made available for each

8-series model:

Application Generator

Download Interface

AG8071

AG8200

AG8300

AG8400

AG8500

AG8600

AG8700

Baud Rate

Vv VvV VvV VvV |V VvV VvV VvV VvV VvV VvV VvV VvV VvV VvV VvV VvV VvV VvV VvV vV vV v v

Cradle-IR
IrDA

RS-232
Bluetooth SPP
USB VCOM

USB VCOM_CDC
Direct RS-232
Cradle-IR

IrDA

RS-232
Bluetooth SPP
USB VCOM
Cradle-IR

IrDA

Bluetooth SPP
RS-232
Bluetooth SPP
USB VCOM

USB VCOM_CDC
FastVPort
RS-232
Bluetooth SPP
USB VCOM

USB VCOM_CDC

By default, the baud rate is set to 115200 bps for the communications via any interface.
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1.5.2 BACKLIGHT

For 8 series mobile computers except 8600 series, the backlight for the LCD and keypad
is disabled by default. Select “Enable” to activate the backlight and specify a time for the
backlight to automatically turn off. Such time-out is specified in the range of 1—~9, in
units of 10 seconds. The default time-out is 20 seconds.

For 8600 series, keypad backlight and LCD backlight are separate controls. The keypad
backlight configuration is the same as 8 series. However, the LCD backlight is always on

(duration assigned with zero) by default. You can determine the idle duration ranging
from 1 to 3 for turning off backlight in 10, 20, or 30 seconds.

1531IP

Enable DHCP

By default, the Enable DHCP checkbox is set to “enabled” and most of the network settings can be
obtained from the DHCP server. If Enable DHCP checkbox is not check, you must manually specify
the following information —

) Subnet Mask
) Gateway

» DNS Server
4

Terminal IP

Server IP

Specify the IP address of the server that you wish to access over wireless network.

Server Port

Specify the server port number. Port 1024 is assigned by default.

SSID

This refers to Service Set ID or Ildentifier, which serves to uniquely identify a group of wireless
network devices used in a given “Service Set”. For example, you need to specify the same SSID
here as is used for access points so the mobile computer can associate to the access points.

Note: SSID can be made up of 32 characters maximum.
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1.5.4 WIFI SECURITY

Authentication and encryption help provide data protection on the 802.11b/g
(802.11b/g/n for 8600) network.

Shared Key/Open System

Two types of network authentication methods are supported: Shared Key and Open System.

Settings

Remarks

Shared Key

Open System

By Shared Key Authentication (SKA), when a client computer attempts to
connect to a WLAN AP, it sends out an authentication request to that AP. Then a
challenge-response handshake by encrypting/decrypting a challenge text using
the pre-configured WEP keys is taken place between the client computer and
the AP. If the AP finally justifies the challenge text it decrypts, it will send back
a positive response to the client computer. Then the client gets to connect to
the network.

» Shared Key Authentication requires a static WEP key configured in the
mobile computer. The mobile computer’s access request can only be
granted when it passed the challenge based authentication of the access
point.

By Open System Authentication (OSA), any wireless device can access any WEP
network and receive files that are not encrypted. When a client computer
attempts to connect to a WLAN AP, it sends out an authentication request to
that AP. The AP authenticates the request and the client gets to connect to the
network.

> Open System Authentication allows any device network access. If no
encryption is enabled on the network, any device that has the SSID of the
access point can gain access to the network.

Note: If Shared Key is selected, you need to specify an active WEP key.

EAP

Select the check box to enable 802.1X authentication (using Extensible Authentication Protocol)
when implementing WEP. It requires user name and password so the mobile computer can identify
itself when associating to an access point.

Settings Remarks

ldentity Specify a user name.

Password Specify a password.
WEP Key
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Select the check box to implement Wired Equivalent Privacy or Wireless Encryption Protocol (WEP)
for data encryption.

Settings Remarks

Key Length Encryption type can be 64 bits (5 bytes) or 128 bits (13 bytes).

> Using 64-bit encryption, the password phrase can be 5 characters long.
From the Grid Control, select up to 5 characters (ASCII codes) for the WEP
key.

» For 128-bit encryption, the password phrase can be 13 characters long.
From the Grid Control, select up to 13 characters (ASCII codes) for the WEP

key.
Key1l~4 Key index number. Up to four keys can be configured.
Active Only one key (the active one) can be used at a time.

Note: You must use the same settings as are configured for other devices on your
wireless network, e.g. access points.

WPA/WPA2 Passphrase

WPA-PSK is supported to enhance security over wireless networks, and this Pre-Shared key mode
requires a passphrase to access the network. The passphrase must be 8 to 63 characters (ASCII
codes). It is used to generate a WEP key automatically.

Note: WPA2-PSK is supported on AG8200, AG8400, AG8600 and AG8700.

1.5.5 FONT FILE

Click the Font File drop-down menu to select a language. After the font language is
selected, the display-only Font File fields on Form and Menu property pages will show the
information accordingly (refer to 1.1.2 Font). The table below lists the font files
supported.

Font File Language Double-byte Single-byte Note

Traditional Chinese

AN

Simplified Chinese

AN

Korean

<

Japanese
English (Default)
Canadian French
Hebrew

Latin (Slovak) Not supported for 8600
Nordic
Portuguese

Cyrillic (Russian) (CP-1251)

NN N N NN
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Turkish

Windows 1250
Greek (CP-737)

Not supported for 8600

Greek (Windows-1253)
Turkish (CP-1254)

Latin (Multilingual Latin I)

Slavic (Latin I1)

Polish (Central European, Latin II)

Latin | (CP-1252)

NN RN N RN RN RN

Click the [Reset] button to load the default settings.
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1.6 STARTUP

On this property page, startup settings for the application program can be customized.

Application Generator - [ New file ]

Form ] Menu ] Lnokup] Barcode] Settings  Startup l

1 Prograrm start from Farm 1 - Redefine menus and messages |Main M enul2=20] j

2 | Data field delimiter : Caomma [.] hd 8

| 1. Take data |1. Take data
3 | Communication Time-out: |10 :I: [17599 sec]
: - 2. Utiities 2. Utites
4 |“ibrator Duration : uli} - |
Startup Colar Froperties |
Background : |- Black j |
5
Fareqground : | White j |
Errar Meszage Color Properties |
Background : | Wihite j |
6 |
Fareground : |- Black j |
7 Import menus and messages ... | |
I Feset |
9

ak. | Canhicel

1.6.1 PROGRAM START FROM

Decide where the application program starts as soon as you select [1. Take Data] on the
mobile computer.

» Form 1
» Menu (= user menu)

1.6.2 DATA FIELD DELIMITER

If no lookup file is associated, the input data will be saved as transaction records. Select
the delimiter used to separate data fields.

1.6.3 COMMUNICATION TIME-OUT
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Set the maximum time for the mobile computer to keep trying to connect to the host
computer.

» A time-out is specified in the range of 1—99, in units of second. The default time-out
is ten seconds.

1.6.4 VIBRATOR DURATION

This setting is available for 8200/8300/8400/8500/8600/8700.

» By default, the vibrator is turned off. You may have it turned on for a preset period of
time upon decoding a barcode or RFID tag successfully.

1.6.5 STARTUP COLOR PROPERTIES (8600 ONLY)

Click the drop-down menus to determine the startup background & foreground colors for
8600 mobile computer.

1.6.6 ERROR MESSAGE COLOR PROPERTIES (8600 ONLY)

Click the drop-down menus to determine the background & foreground colors of error
message for 8600 mobile computer.

1.6.7 IMPORT MENUS AND MESSAGES

If the menus (i.e. prompts of the main menu and submenus) and messages have already
been re-defined with an existing template file, simply import the template file. Click the
button to bring up a dialog box and locate the application template file (*.ATF).

1.6.8 REDEFINE MENUS AND MESSAGES

For non-English environment, all the menu prompts and messages need to be re-defined
in your local language. In addition, the appropriate font file has to be downloaded to the
mobile computer so it can display the prompts and messages in Form and Menu (user
menu) correctly. Refer to Localization.

1.6.9 RESET

Click this button to load the default settings.

Note: The current settings will be cleared.
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Chapter 2
WIRELESS DATABASE MANAGER

Wireless Database Manager lends itself to real-time data exchange, by updating
and/or editing database on the host computer. Working with the 8000/8200/8300/8400/
8500/8600/8700 Series mobile computers, it easily creates or links to a back-end
database according to the pre-defined properties of lookup file(s).

Access Point | || | ]l

L

Take Data Link to Database

Wireless Database Manager

Slaieaizizizialel

!

O e

:
!
:

LEE L -l_.:
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In order to connect to the host computer running Wireless Database Manager or the
“WLAN Read” utility, the mobile computers must be capable of 802.11b/g wireless
connectivity (or 802.11b/g/n for 8600) —

v

8071
8230
8330
8370
8470
8570
8630
8770
8790

v Vv VvV VvV VvV Vv v Vv

Sparing your time from the tedious work of writing codes, Wireless Database Manager
gets your data linked to a number of legacy OLE database easily. If one or more lookup
files are associated with the application template, you can update the database (lookup
file) at the same time. If no lookup file is in use, you may use the standalone utility
WLAN__Read.exe instead.

Note: The properties of lookup file(s) must be defined using the WLAN Application
Generator.
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2.1 MAIN WINDOW

The main window of Wireless Database Manager has menus and toolbars on the top,
and, the rest of the window displays the database in use or RF Reading section.

‘E Wireless Database Manager

Editing Toolbar

RF Reading Toolbar

File RFLink Help

s | &

Disconnect Save As

2|

Print

r:r‘@/m

Add Edit Delete

B‘ﬁ"

Find Sort

S
Setting

Stop

‘ Device bar

Toolbars

Database T RF Reading ]
TDEMO " B Name Qty DATE TIME
1000 CCDBarcodeScanner | 100 2015/07/02 16:08:44
1090 CCDBarcodeScanner | 100 2015/07/02 16:08:44
1100 LinearScanner 100 2015/07/02 16:08:44
1105 EntryLevelScanner 100 2015/07/02 16:05:44
p |1166 BETWirelessScanner |100 2015/07/02 16:08:44
1266 BETWirelessScanner |100 2015/07/02 16:08:44
8001 PortableTerminal 100 2015/07/02 16:08:44
8061 BTWirelessTer 100 2015/07/02 16:08:44
8071 WirelessTerminal 100 2015/07/02 16:08:44

Status Bar

| 4| 5/9 Records

¥

Local Port: 1024

Note: The data file tab(s) varies with the lookup file attributes.

(1) The Database tab will be brought up when the application template contains a

data collecting form that is set to refer to a lookup file.

(2) The RF Reading tab will be brought up when the application template contains
a form that doesn't make reference to lookup file(s).

2.1.1 DATABASE TAB

When you click on the Database tab, it displays in two panes — title of tables on the left
(It can display up to three tables.), and content on the right.

Note: The properties of lookup file(s) must be defined using the WLAN Application

Generator.

2.1.2 RF READING TAB

When the application template file (ATF) includes a form that doesn't make reference to
lookup files, the RF Reading dialog box appears right after executing the Open ATF

command.

Note: The data received will be saved in text format (*.txt).
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Sparing your time from the tedious work of writing codes, Wireless Database Manager
gets your data linked to a number of legacy OLE database easily. If one or more lookup
files are associated with the application template, you can update the database (lookup
file) at the same time. If no lookup file is in use, you may use the standalone utility
WLAN _Read.exe instead.

RF Reading 5
Date && Time stamp : Add to record’s top j
Directory - | 1ab\Wireless DB Manager Browse v e Date stamp and Time stamp.
Date Format - YYYY/MM/DD
File name : | 1.TXT €
¥ Year 4 Digits (YYYY) ~|
File mode : Overwrite ~ [+ Month
v Day
[+ Add Retum character to each record.
B [+ Separator 7/
[+ Add Line-Feed character to each record. Date Style | Year.Month.Day j
[ Character replacement (ASCII) - 44 —: | 59 Time Format - HH:MM:55
[+ Hour
[ Add Date && Time stamp : << ¥ Minute
[+ Second
v Separator :
OK Cancel

Option To Do...

Directory Specify where the data is to be saved by entering file path or click
[Browse] to select a location.

File name Enter file name.

File mode Choose file mode: Overwrite, Append or New Name.

Add Return character When selected, it will add Return character to each record.

Add Line-Feed character When selected, it will add Line-Feed character to each record.

Character replacement When selected, it will perform character replacement as specified.

(ASCII)

[Original value === New value]

Add Date & Time stamp When selected, it will add system date and/or time stamp to each
record. Click [>>] to open system date and time settings.

After defining the RF Reading settings, there appears the RFE Reading Toolbar as well as
the RF Reading Tab. When you click on the RF Reading tab, it simply displays data
received.
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2.2 MENU BAR

The Menu Bar contains a number of menus that specify which task you want the system
to perform. Each menu contains a list of commands and sometimes sub-menus.

Some of the options carry out commands immediately while the others display a window

that requires user’s further input of additional information. If a label is followed by [...], it
displays a window; otherwise it deals with a command carried out immediately.

2.2.1 FILE MENU

The File Menu contains the commands and submenus that cause the following actions to
be carried by the mobile computer:

!E Wireless Database Manager

RF Link Help
Open ATF...
Open Database
Close: W8200_Basic_Demo.ATF

Open WDM...
Save As WDM...
MNew Database
Convert Data r
Data Links...
Save As...
Print...
Preferences...
Exit
Command Action
Open ATF Open an existing application template file (*.ATF) that was created by the
FORGE WLAN Application Generator.
> ATF refers to "Application Template File".
Open Database If the database has been successfully created earlier, you can directly open

Open RF Reading it without having to re-open the application template first.

» When the previously opened template includes RF Reading only, the
command is Open RF Reading.

» When it includes Database or Database + RF reading, the command is
Open Database.

Close: (ATF file name) | Close the currently opened application template file.

Open WDM Open an existing .WDM file that was created by Wireless Database
Manager.
Save As WDM... Save the current ATF with Data Link properties as a WDM file.
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New Database

Convert Data

Data Links

Save As

Print

48

Create tables in the local database “DBF.mdb” from scratch. Up to three
tables are allowed.

Convert the source text data of a lookup file (.txt) and import it to the local
database “DBF.mdb”. It allows up to three lookup files.

> Make sure that all required lookup files have been converted to
database completely.

> If the date/time stamps in the ATF have been defined, a dialog box will
prompt to confirm whether the system is to generate the date/time
stamp for the records automatically.

It supports a variety of database types. Configure the Data Link properties
and link to any legacy back-end database.

Save the current database to a new file either in database format (*.mdb)
or in text format (*.txt).

Print out data from the current database.
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Preferences Configure custom settings for security concerns and others.

» Preload the last editing file at startup enables automatic execution of
the command Open ATF or commands Open ATF/Open
Database/Connect, depending on the state of the last time when you
exit the program.

» Password protection can only be applied when you give a non-blank
password and select at least one from the available options.

» If your database does not accept SQL commands with field/table name
containing special characters, such as spaces, period, etc., make sure
you select the check box of [Field/table name contain special
character]. As a result, the field/table names will be enclosed in a pair
of square brackets when sending SQL commands, for example, SELECT
[Field 1], [Field 2] FROM [Table].

x|

ﬁ Preload the last editing file at startup.

E&RF Link Menu | Properties
[” Password protection for RF Link properti

[T Paszsword protection for Data editing. Databa_se Toolbar:
Add/Edit/Delete

[~ Password protection for Save As & Print.

r Password protection when exit Wireless DB
Manager_

[~ Password protection for Connect & Disconnect

[T Password protection for Setting. <:F RF Reading Setting

Password:

[~ FeldAable name contain special character.

[T Sawe transaction data to a tex file.

File name : I _l

Exit Close the Wireless Database Manager program.
2.2.2 RF LINK MENU

The mobile computers must connect to the host computer through the Access Points
(hereinafter “APs”). After a careful site survey, you may decide to have a number of APs
on your network.

In this case, the mobile computers connecting to the host computer are called "Client"
while the host computer is called "Server".
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ELEEE Wireless Database Manager

File | Ecl_ink Help
o

nnect

Disconnect

Properties...

The RF Link Menu contains the following commands that trigger the following actions of
the mobile computer:

Command Action

Connect Enable the wireless connection between Host PC and the mobile computers
through APs.

Disconnect Disable the wireless connection between Host PC and the mobile computers
through APs.

Properties Configure the COM port settings —

> Assign local port

> Define the number of supported clients

Note: The number of the symbolic icons on the Device Bar reveals how many mobile
computers are currently connected.

2.2.3 HELP MENU

Y% Wireless Database Manager

File RFLink | Help
iew log ...
About ATF File's Properties. ..
About Wireless Database Manager...

Command Action

View log Open the Log Manager to view the activities or events occurred in Wireless
Database Manager.

> The system log file is named “Wireless Database Manager.log” that will be
over-written every time you re-start Wireless Database Manager.

About ATF File's Show properties of the application template file if a lookup file is specified in
Properties use and imported or created accordingly.

About Wireless  Show information about Wireless Database Manager.
Database Manager
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2.3 TOOLBARS

The toolbars give you quick access to available commands in the current stage of
application.

& - Iz | Ok

File Connect Exit

Dpen Database [g D

&S | | &

File Disconnect Exit
* *'|\!| Device Bar
This Button Does The Same As This
File File Menu | Open ATF

File Menu | Open Database | Open RF Reading
Connect | Disconnect RF Link Menu | Connect | Disconnect

Exit File Menu | Exit

Note: Device bar will appear after you first click [Connect].

2.3.1 DATABASE TOOLBAR

After opening the application template file, these buttons will appear when at least one
form is referred to a lookup file.

& | " | Za

Mew Datab... | Convert Data Data Link

This Button Does The Same As This
New Database File Menu | New Database
Convert Data File Menu | Convert Data
Data Link File Menu | Data Link

Note: The Convert Data button won't go away as long as there is more data (another
lookup file) needs conversion.

After having imported or created a table, these buttons will appear.
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& | ©

Save As Print
This Button Does The Same As This
Save As File Menu | Save As
Print File Menu | Print

You can use the Editing Toolbar to manually manage the received data in the database.

1 = s s

Add Edit Delete Find Sork
Button To Do...
Add Add a record to the database.
Edit Edit the data of the selected record.
Delete Delete the selected record.
Find Search the database according to the specified key field.
Sort Sort the records based on the specified key field by ascending or descending.
2.3.2 RF READING TOOLBAR

After opening the application template file, these buttons will appear when at least one
form is NOT referred to any lookup file.

Setting Stop

-OR -
Button To Do...

Setting Click this button if you need to re-define the RF Reading setting.
Stop Click this button to stop or start the recording of the received data.
2.3.3 DEVICE BAR

The icons on the Device Bar quickly inform you how many mobile computers are
currently connected.

192.165.6.2135

Move your cursor near to a symbolic icon, and the information of its IP address will
appear. Click the icon of a mobile computer to view its IP address and COM port number.
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2.4 RF READING TAB

This RF Reading Tab appears after configuring the RF Reading setting. When you click on
the RF Reading tab, it simply displays data received.

Database T RF Reading ]

Receive : 0 records.

Note: The Save As and Print commands are not accessible.

2.5 DATABASE TAB

The Database tab lists up to three tables. You may click on any record, and then click the
editing tools to edit it.

Database [% T RF Reading ]
Lookup_Sample DATE ITEM [NAME [aTy TIME
p |2005/04/04 9950 |Coke 1000 18:28:36
2005/04/04 9951 Candy 120000 18:28:36
U0 gein et 2005/04/04  |952 Softdrink 300 1626:36
2005/04/04  |9953 Cigarette 4000 18:28:36
gf'a‘; 2005/04/04 {9954 Wine 500 182836 | tme
12005;04;04 9955 Pencil 6000 18.26:36 amp
2005/04/04 | 9956 |Book [777 16:28:36
2005/04/04 | 9957 Notebook |80 18:28:38
2005/04/04 99658 |Charger 900 18:28:36
2005/04/04 | 9959 |Scanner 10000 18:28:36
4| 4] 1 /10 Records Al
=y / [ Nextrecos
Last record

Previous record Current record

» On the right pane of the database window, you'll find the triangular indicator ("’ )
points toward the current entry of record. You may click on any other entry to move
the indicator, and then proceed to edit the record.

» On the bottom of the database content is a horizontal scroll bar. You may use the

M| 4 (L

right/left scroll arrows ( and ) to scroll through the list of records.
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2.6 STATUS BAR

The Status Bar is located at the bottom of the application window. It gives information on
the data sending and receiving activities that occur between the host computer and the
mobile computers.

| (113957 0113357 Moteboolk, 30 Local Port: 1024 R
Message Column Gives Information On...

|E!'|'|995? Data received from the local port.

|D11995F,Nutebunk,8[l Command or data sent out from the local port.

Local COM port properties when it is open. It will show

Local Port: 1024
i 4 "COM Properties" when the COM port is closed.

54



Chapter 3
DEMONSTRATION

This chapter gives more information on how to use Wireless Database Manager.

3.1 GETTING STARTED

) Run Wireless Database Manager, and the application window pops up.

2) For a fresh start, click File Menu | Open ATF to start with a new application
template.

In the template, say, Form 1 refers to “1°%" lookup file” and Form 2 refers to none.

Note: The application template file (ATF) has to be defined properly with the WLAN
Application Generator before you can make use of it with the Wireless Database
Manager.

3) Configure the RF Reading settings in the RF Reading Dialogue (because Form 2
doesn’t refer to a lookup file).

4) The RF Reading tab is displayed for receiving data.

5) Click [New Database] to create the first table from scratch, or click [Convert Data #1]
to import the lookup file (.txt), or click [Data Link] to access a remote database (for
Form 1 refers to “1° lookup file”).

& | B || C=

Mew Datab... | Convert Data Data Link

#3...

The Database tab is displayed for receiving data.

Note: The Convert Data button won't go away as long as there is more data (another
lookup file) needs conversion.

6) Click [Connect] to wait for mobile computers to start a connection. The Device Bar
appears to indicate the connection status.

& | | (&

File Disconnect Exit

=R LY
NN
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7) Turn on your mobile computer and select [1. Take Data] to connect to the server.

Make sure that you have downloaded the same template file and configured the
Server IP and port number correctly.

8) Data collected via Form 1 and Form 2 will be displayed on the Database tab and RF
Reading tab separately.

3.1.1 CONFIGURE DATA LINK PROPERTIES
Configure the Data Link properties and link to any legacy back-end database. Take the
following for example.

) Click [Data Link] from the toolbar to bring up the Properties dialog box.
2) In the Provider tab, select [Microsoft Jet 4.0 OLE DB Provider].
3) Click [Next =>=>].

B Data Link Properties x|

Provider I Connection | Advanced | &1l |

Select the data you want ko connect ko

[LE DE Prowider|z]

[BM DBZ2 UDE far iSenes OLE DB Provider
Micrazoft 154k 1.1 OLE DB Prowvider
Microsoft Jet 4.0 OLE DB Provider

Microzoft OLE DB Prowvider for Indesing Service
Microzaft OLE DB Prowider for Intermet Publizhing
Microzaft OLE DB Provider for ODEC Drivers
Microzoft OLE DB Provider for OLAP Services
Microsoft OLE DB Provider for Oracle

Microzoft OLE DB Prowider For SOL Server
Micrazoft OLE DB Simple Provider

kS0 ataShape

OLE DB Provider for Microsoft Directony Services

k. | Cancel | Help |

4) In the Connection tab, specify the name of target database (Microsoft Access
Database: *.mdb) and provide other required information.

5) Click [Test Connection] to verify connection.

6) Click [OK] when initial connection is set up successfully.
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Ef) Data Link Properties x|

Provider Connection |.-’-'-.u:|vanu:ed| &l I

Specify the following to connect to Access data;

1. Select or enter a databasze name:

2. Enter information to log on to the databaze:

IJzer name: I.-'l‘-.dmin

Fazzword: I

¥ Blank password [ Allow saving password

T ezt Connection |

(] | Cancel | Help |

MAP LOOKUP FILE

) When the lookup file is connected to database, make sure the mapping between them
is correct.

» The table (i.e. Sample 1) of database is mapped to the lookup file specified in the
application template (ATF).

» The database fields are automatically mapped to the data fields of the lookup file.

2) If your database file doesn't have as many fields as the lookup file does, a warning
message will be displayed as the figure shown below.
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¥ Map Lookup File x|
Lookup 15t lookup file | Table : Sample_1 =]
Field Prompt Data type Mapping field Data type
#1 | DATE | yyyy/mmidds | DATE x| | advarwChar
#2 | ITEM | text [ 1TEM = | advawChar
#3 | NAME | test | NAME =l | advarwChar
#4 | ory | integer | ary =| | adinteger
#5 | TIME | +hh:mm:ss — TIME x| | advarwChar
" | | e |
NAME
w7 | |
us | |
w | |
o | |
0K Cancel |
x
Lookup - | 18t lookup file | Table - | Lookup_Sample =]
Field Prompt Data type Mapping field Data type
#1 | tem | integer | temNo =] | adinteger
#2 | Name [ text | Desc =] | advarWChar
#3 | Quantity | integer | aty || adinteger
#4 | DATE | +yyyymmdd | [
#5 | TIME | +hh:mm:ss — | | =i
- | Map Lookuprie ﬁ
w [
e I— 3 Sample 1 does not have enough fields to complete the mapping For 15t lookup File 1
w [
wmo [ k

OK Cancel |
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3) When data is mapped correctly, click [OK]. Data link to back-end database is set up
successfully.

3.1.2 EDIT DATA

You can use the Editing Toolbar to manually manage the received data in the database.

O = s s

add Edit Delete Find Sart

A
i

ADD A RECORD

x

DATE | 2005504f11
ITEM | mda a recora
CATEGORY | Example

QrY | 4

TIME | 14:-48:31

Update [ ! LCancel

) Click [Add] on the toolbar.

2) The dialog box showing up contains fields of a single record for input.
3) When input is completed, click [Update].
4) The new record will be added to the bottom of the list.
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DATE ITEM CATEGORY |QTY TIME
2005/04,11 Coke Grocery 11 14:33:01
2005,/04411 Candy Grocery 20000 11:20:49
20050411 Soft drink Grocery 300 11:20:49
200504411 Cigarette Grocery 4000 11:20:49
20050411 Wine Grocery 500 11:20:49
2005/04,11 Pencil Grocery GO00 11:20:49
20050411 Book Grocery 77 11:20:49
2005/04,11 Motehook Grocery al 11:20:49
20050411 Charger Grocery 900 11:20:49
2005/04/11 Scanner Grocery 10000 11:20:49

p (200504411 Add a record Example 1 14:43:31

EDIT A RECORD
x

DATE | 2008704711

ITEM I Edit h record

CATEGORY | Example

ary | 1

TIME | 13:48:31
Update [:% Lancel

) Click on any part of a record to have the triangular indicator ( » ) point to the record.
2) Click [Edit] on the toolbar.

3) The dialog box showing up contains fields of a the selected record for editing. When
input is completed, click [Update].

4) The edited field(s) of the original record will be updated with new input.

60



Chapter 3 Demonstration

DELETE A RECORD

i

DATE | 2005704711
ITEM | Eait a recora
CATEGORY | Example

aty | 1

TIME | 13:48:31

LCancel

) Click on any part of a record to have the triangular indicator ( » ) point to the record.
2) Click [Delete] on the toolbar.

3) The dialog box contains fields (grayed out) of the selected record. Make sure you
want to get rid of the record before clicking [Delete]. The record will be deleted for

good.

FIND A RECORD
x|
Previous N
Field : | T R g
Hext
Data : I example
Cancel

) If you need to check on something on a long list, click [Find] on the toolbar.

2) Click the Field drop-down menu to select among key fields (as many as one record
contains) and specify the content of the selected field.

3) Click [Previous](records before the current item) or [Next](records after the current
item) to start searching.

» When a certain record is found, you'll find the triangular indicator ( > ) pointing to
it.
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» Otherwise, you'll be prompted with a message indicating “Data Not Found!”

SORT RECORDS
o
Field - [ =] e |
i* Azcending i~ Descending Cancel |

) If you need to sort information on a long list, click [Sort] on the toolbar.

2) Click the Field drop-down menu to select among key fields (as many as one record
contains) and the sort methods (Ascending or Descending) for specifying your
requirements.

3) Click [Start].
4) Examples:

» Sorting by Name/Ascending

DATE ITEM INAME %+ |oTY TIME
p [2005/05/03 | 9956 |Baok 777 13:47:34
2005/05/03  |9851 |Candy 20000 13:47:34
2005/05/03  |9958 |Charger 300 13:47:34
2005/05/03  |9953 |Cigarette 4000 13:47:34
2005/05/03 | 9950 |Coke 1000 13:47:34
2005/05/03  |9957 INatehook {80 13:47:34
2005/05/03  |9955 IPencil 5000 13:47:34
2005/05/03  |9959 Scanner 10000 13:47:34
2005/05/03  |9952 Soft drink 300 13:47:34
2005/05/03  |9954 ine 500 13:47:34

» Sorting by Quantity/Descending
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DATE ITEM NAME Q1Y + |TIME

2005/05/03 8951 Candy 20000 13:47:34
2005/05/03 4354 Scanner 10000 13:47:34
2005/05/03 9355 Fencil {6000 13:47:34
2005/05/03 4353 Cigarette 4000 13:47:34
2005/05/03 3350 Caoke 1000 13:47:34
2005/05/03 4358 Charger 400 13:47:34
2005/05/03 9356 Boaok T 13:47:34
2005/05/03 4354 Wine (=00 13:47:34
2005405403 9352 Soft drink, 300 13:47:34
2005/05/03 9357 Moteboaolk, {ao 13:47:34

3.2 PRINT

) Select a table from the Database tab.

2) Click File Menu | Print or the [Print] button on the toolbar to set properties (see

below).

3) In the print properties, click [Print] to select printer.
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3.2.1 PRINT PROPERTIES

Received data displayed on the Database tab can be printed out. Before printing, you
may need to configure the layout settings to meet your needs.

Option Description
Report > Title: of the printout, optional
» Person: who produced the printout, optional
Space > Field: space between fields, in millimeter
» Line: space between lines or records, in millimeter
Field » Wwidth: of each field, in millimeter
» Height: of each field, in millimeter
Margin » Top: margin size from top to the edge of paper, in millimeter
» Bottom: margin size from bottom to the edge of paper, in millimeter
> Left: margin size from left to the edge of paper, in millimeter
» Right: margin size from right to the edge of paper, in millimeter

x

Report
Title - I Sample 1
Person : I
Space (mm) Field [mm]
Field : 0.35 Width : 20.28
Line : 1.76 Height : I 6.08

— Margin [mm]

Top: 353 Bottom :

7.94
Left : 1.76 Right : I 3
........... P;exmw ............ Puint | Cancel
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3.2.2 PREVIEW

You may click [Preview] to take a glance at the printout.

Option Description
Zoom |1UU°/= =] select an appropriate preview size.
ﬁ‘l Export it (all or by page) to different file formats.

> HTML (*.htm; *.html)

P Text (*.txt)

» Unicode HTML (UTF-8)(*.htm; *.html)
> Unicode Text (*.txt)

Send to print if the layout satisfies your needs.
e ol x]
) Zoom [100% -]

N

Sample 1

DATE ITEM CATEGORY QTY TIME
200540411 Coke Grocery 1000 11:20:43
200540411 Candy Grocerny 20000 11:20:43
2005/04/11 Soft drink Grocerny 300 11:20:43 i
200540411 Cigarette Erocery 4000 11:20:43
2005/0411  Wine Erocery a00 11:20:43
200540411 Pencil Grocery G000 11:20:49
20050411 Book Groceny i 11:20:49
200540411 Hatebook Grocery a0 11:20:43
200540411 Charger Grocerny 300 11:20:43
200540411 Scanner Eroceny 10000 11:20:43

-
-
4

Pages: HI{I'I HH'
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3.3 VIEW ATF FILE'S PROPERTIES

In Wireless Database Manager, you can view the settings of the opened application
template if a lookup file is specified in use and imported or created accordingly.

Click Help Menu | About ATF File’s Propertjes
Version of AG program used to

{5 ATF File's Properties create this template file. x|
— ATF's Properties
File name - [ 8500 WLAN Demo ATF Version - ]%
Form's Properties 1 Lookup's Properties )
Mame: | foml  v| Esc- [ Mainmenu  Lookupfile - [ st tookup file
Fortt - |T Next - |r No match action - | insert to lookup file
Line  Datatype Prompt Input source Min length Max length Lookup  Properties
# | text | tem: | both | o | 50 | field 1 Ll
#2 | lookup | Description- | both e | 50 | field 2 M
#3 | integer | Quantity- | keypad | 0O | 50 | field 3 Ll
#4 | il | | both | o | 50 [ i M
#5 | ni | | both | 0 | 50 | il more..
#6 | ni | | both e | 50 [ i ﬂl
#7 | ni | | both e | 50 | ni more...
#8 | nil | | both G | 50 | il more._

It reveals the relationship between the application template and Wireless Database
Manager.

In the Application Generator's template: In the Wireless Database Manager:
1st lookup file Convert Data #1
2nd lookup file Convert Data #2
3rd lookup file Convert Data #3

Note: The ATF's properties cannot be changed here.
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SCAN ENGINE SETTINGS

The FORGE WLAN Application Generator allows configuring the following reader types,
depending on the module equipped on your mobile computer:

8000 | 8200 | 8300 | 8400 | 8500 | 8600 | 8700
Barcode Reader
1D CCD Scan Engine v v v
1D Laser Scan Engine v v v
1D Long Range Laser Scan Engine (LR) x x 4 x v x v
1D Extra Long Range Laser Scan Engine | * x x x v x x
(ELR)
2D Scan Engine x v x v v v v
RFID Reader
ACG_RFID Module v0.9 x x x x v x x
ACG_RFID Module v1.0 x x v x v x x
HF RFID Multi-1SO v1.2.2 x x x x x v v

Options of different reader combination are allowed, such as 1D+RFID and 2D+RFID. For
each combination, both readers can be initialized and ready for scanning at the same
time (dual mode operation). For example, if you press the [Scan] button while running
the AG run-time program on the mobile computer, it will read a barcode in position or an
RFID tag in proximity depending on which one comes first.

Note: You cannot have 1D+2D scan engines installed on the mobile computer because
they are both barcode readers!
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SYMBOLOGIES SUPPORTED

Varying by the scan engine installed, the supported symbologies or tag types are listed
below. For details on configuring associated settings, please refer to each Appendix
separately.

CCD, Laser |LR, ELR 2D
Codabar v v
Code 11 x (v)Note

Note: Code 11 is supported on Long Range Laser scan engine for 8300 only.

Code 93 v v

Composite Code x x

MSI v v

Plessey v x x

Postal Codes x x v

Telepen 4 x x

Code 128 Code 128 v 4 v
GS1-128 (EAN-128) v v v
ISBT 128 v 4 v

Code 2 of 5 Industrial 25 (Discrete 25) v v v
Interleaved 25 v v
Matrix 25 v x (v)Nete
Chinese 25 x x (v)Note
Coop 25 (V)Nee x x

Note: (1) Matrix 25 and Chinese 25 are supported on 2D scan engine for
8200/8400/8600/8700 only.
(2) Coop 25 is supported on CCD/Laser scan engine for 8200/8600/8700 only.

Code 3 of 9 Code 39 v v v
Trioptic Code 39 x 4 v
Italian Pharmacode (Code 32) v v 4
French Pharmacode v x x
EAN/UPC EAN-8 v 4 v
EAN-13 4 v v
Bookland EAN (ISBN) v v v
UPC-EO 4 v v
UPC-E1 (V)Nee v v
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Scan Engine Settings

UPC-A

Note: UPC-E1 is supported on CCD/Laser scan engine for 8200/8600/8700.

GS1 DataBar
(RSS)

GS1 DataBar Omnidirectional (RSS-14)

GS1 DataBar Truncated

GS1 DataBar Stacked

GS1 DataBar Stacked Omnidirectional

GS1 DataBar Limited (RSS Limited)

GS1 DataBar Expanded (RSS Expanded)

GS1 DataBar Expanded Stacked

NIIEN RN RN RN IRV RN

NIIEN RN RN RN IRV RN

2D Symbologies

PDF417

x

x

MicroPDF417

Data Matrix

Maxicode

NIIEN RN IRV RN RN IRV RN IRV IRN) IRN

QR Code

MicroQR

(‘/) Note

Aztec

(\/) Note

Note: MicroQR and Aztec are supported on 2D scan engine for 8200/8400/8600/8700

only.

RFID TAGS SUPPORTED

The RFID reader supports read/write operations depending on the tags. The supported

labels include 1SO 15693, Icode®, ISO 14443A, and

ISO 14443B. Currently, the

performance of some tags has been confirmed, and the results are listed below for your
reference. The results found may vary in RFID module version.

Note: You should study the specifications of RFID tags before use. The

functionality may not be supported.

HF RFID Multi-ISO Version 1.2.2

"Write Page"

UID Only

Read Page

Write Page Note

I1SO 14443A | Mifare Standard 1K (Mifare S50)

Mifare Standard 4K (Mifare S70)

Jcop 41 only the (Mifare 1K & 4K compatible)

Mifare Ultralight

Mifare Ultralight C

Mifare ProX

Mifare DESFire

NIIEN IRV IRV IRV IRV RN

D N N O N N AN

DN N N N N RN
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Mifare Plus

Mifare Mini (Mifare S20)

SLEG66CLX320P

SLE55R04 / 08

Smart MX

Jewel

Topaz

1SO 14443B

SLE6666CL160S

SR176

SRIX4K

SLIX 4K

Dual

I1SO 14443A compliant

1SO 14443B compliant

1SO 15693

EM4135

ICode SLI

LRI12

LRIG4

LRI128

LRI2k

SRF55VxxP

SRF55VxxS

Tag-it HF-1 Std

TempSense

ICODE1 with EAS&AFI

Icode

NIIEN RN IRV IRV IRN IRV IRV IRV IRN) IRV IRN IRN) IRV IRV IRV ERNL ERNY RN RN RN ERNY IRNY RN RN
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ACG_RFID Module Version 1.0 UID Only Read Page Write Page Note
ISO 14443A  |Mifare Standard 1K v v v
Mifare Standard 4K v v v
Mifare Ultralight v 4 v
Mifare DESFire v - —
Mifare S50 v v v
SLE44R35 v —_— ——
SLE66R35 v v v
1SO 14443B SRIX 4K v v v
SR176 v 4 v
1SO 15693 ICODE SLI v 4 v
SRF55V02P v - ——
SRF55V02S v —_— ——
SRF55V10P v —_— ——
Tl Tag-it HF-1 v 4 v
ICODE® ICODE v v v
(Phillips)
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ACG_RFID Module Version 0.9

UID Only

Read Page

Write Page Note

1SO 14443A

Mifare Standard 1K

Mifare Standard 4K

Mifare DESFire

Mifare S50

SLE44R35

SLEG6R35

1SO 15693

ICODE SLI

SRF55V02P

SRF55V02S

SRF55V10P

Tl Tag-it HF-I

ST LR164

ST LRI1512

Tagit®

Tagit

ICODE®
(Phillips)

ICODE

NN R R RN

DN I N N N (N RN
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CCD/LASER SCAN ENGINE

The tables below list reader settings as well as symbology settings for the CCD or Laser
scan engine.

READER SETTINGS TABLE

CCD/Laser Engine Description Default
Scan Mode Laser mode
Continuous Mode Non-stop scanning

» To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode Non-stop scanning

» Capable of decoding the same barcode repeatedly

Repeat Mode Non-stop scanning

> Capable of re-transmitting barcode data if triggering within one second
after a successful decoding

Momentary Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until you release the trigger.

Alternate Mode Press the scan trigger to start with scanning.

» The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.

» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.

Laser Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode Press the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Auto Power Off Mode Press the scan trigger to start with scanning.

» The scanning won't stop until the preset timeout expires, and, the
preset timeout period re-counts after each successful decoding.

Read Redundancy None

None No redundancy means one successful decoding will make the reading valid
and induce the "READER Event".
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One time, Two times, | The higher the reading security is (that is, the more redundancy the user
or Three times selects), the slower the reading speed gets.

> If "Three Times" is selected, it will take a total of four consecutive
successful decodings of the same barcode to make the reading valid.

Time-out 3 sec.

0—~255 (second) Set the maximum time for decoding to continue during a scan attempt. It
applies to the following scan modes only —

» Aiming mode

» Laser mode

> Auto Off mode

» Auto Power Off mode

Aiming Duration 3 sec.

1~255 (second) Set the maximum time for decoding to continue during a scan attempt.

> It applies to Aiming mode only.

Note: Aiming Duration is supported on CCD/Laser scan engine for
8000/8200/8300/8400/8500/8600/8700.
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CCD/Laser Scan Engine

SYMBOLOGY SETTINGS TABLE

CCD/Laser Engine Description Default
Codabar Enable
Transmit Start/Stop | Decide whether to include the start/stop characters in the [No
Character data being transmitted.
If "Transmit Start/Stop Characters" is desired, select one
set:
» abcd / abcd
» abcd/ tn*e
» ABCD / ABCD
> ABCD / TN*E
Code 128 Enable
GS1-128 Enable
Transmit Code ID (for|Decide whether to include Code ID (“]JC1”) in the data|No
GS1-128) being transmitted.
Field Separator | Decide whether to replace the field separator. If the|No
Replacement barcode contains Field Separator “Ox1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field
separator. Then if the barcode contains Field Separator
“Ox1D”, it will be changed to “;”.
ISBT 128 Enable
Note: ISBT 128 is supported on 1D scan engine for 8200/8400/8600/8700.
Industrial 25 (= Discrete 25) Enable
Start/Stop Selection This decides the readability of all 2 of 5 symbology|Industrial 25
variants. For example, flight tickets actually use an
Industrial 2 of 5 barcode but with Interleaved 2 of 5
start/stop pattern. In order to read this barcode, the
start/stop pattern selection parameter of Industrial 2 of 5
should be set to "Interleaved 25".
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
Select Length » One or two fixed lengths 1-127
> Range
Interleaved 25 Enable
Start/Stop Selection Refer to Industrial 25. Interleaved
25
Verify Check Digit Decide whether to verify the check digit. If the check digit|No

is incorrect, the barcode will not be accepted.
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Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Select Length » One or two fixed lengths 1-126

> Range
Matrix 25 Disable
Start/Stop Selection Refer to Industrial 25. Matrix 25
Verify Check Digit Decide whether to verify the check digit. If the check digit|No

is incorrect, the barcode will not be accepted.

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Select Length » One or two fixed lengths 1-127
> Range

Coop 25 Disable

Verify Check Digit Decide whether to verify the check digit. If the check digit|No

is incorrect, the barcode will not be accepted.

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Note: Coop 25 is supported on CCD/Laser scan engine for 8200/8600/8700 only.

French Pharmacode Disable

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Italian Pharmacode (= Code 32) Disable

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Note: For French/Italian Pharmacode, “Transmit Start/Stop Character” is not provided in
Ul but it is controlled by the same setting of Code 39.

Code 39 Enable
Transmit Start/Stop | Decide whether to include the start/stop characters "*" in[No
Character the data being transmitted.

Verify Check Digit Decide whether to verify the check digit. If the check digit|No

is incorrect, the barcode will not be accepted.

Transmit Check Digit Decide whether to include the check digit in the data being| Yes
transmitted.

Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and |Disable
special characters.

Security Level » High High
» Normal

Code 93 Enable

76




Appendix Il

CCD/Laser Scan Engine

MSI

Disable

Verify Check Digit

Select one of the three calculation formulas to verify the
check digit. If the check digit is incorrect, the barcode will
not be accepted.

» Single Modulo 10
» Double Modulo 10
» Modulo 11 & 10

Single Modulo
10

Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

» Last digit not transmitted

Both digits
transmitted

» Both digits transmitted
» Both digits not transmitted
Select Length » One or two fixed lengths 1-127
» Range
Negative Barcode Disable
Plessey Disable
Convert to UK Plessey |When applied, each occurrence of the character "A" in the [No
barcode data will be replaced by the character "X".
Transmit Check Digit Decide whether to include the two check digits in the data|Yes
being transmitted.
Telepen Disable
Original Telepen | The original Telepen includes numeric characters. No
(Numeric)
AIM Telepen (Full | AIM Telepen (Full ASCII) includes all the alphanumeric and |Yes
ASCII) special characters.
GS1 Databar-14 Disable

GS1 DataBar-14 is short for GS1 DataBar Omnidirectional. This group consists of (1) GS1 DataBar
Omnidirectional, (2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and (4) GS1 DataBar
Stacked Omnidirectional.

Transmit Code ID Decide whether to include Code ID ("]e0™) will be included | Yes
in the data being transmitted.

Transmit Application | Decide whether to include the Application ID ("01") in the|Yes

ID data being transmitted.

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

GS1 Databar Limited Disable

Transmit Code ID Refer to GS1 Databar-14. Yes

Transmit Application | Refer to GS1 Databar-14. Yes

ID

Transmit Check Digit Refer to GS1 Databar-14. Yes
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GS1 Databar Expanded

Disable

This group consists of (1) GS1 DataBar Expanded, and (2) GS1 DataBar Expanded Stacked.

Transmit Code ID Refer to GS1 Databar-14. Yes
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the |No
next processing will follow the settings configured for
EAN-13.
> After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).
GTIN-13 Format Decide whether to convert using GTIN-13 format. No
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
Addon 2 / Addon 5 Decide whether to decode EAN-8 with addons. No
EAN-13 /7 UPC-A Enable
ISBN Conversion The EAN-13 barcode starting with 978 and 979 will be|No
converted to ISBN.
ISSN Conversion The EAN-13 barcode starting with 977 will be converted to|No
ISSN.
GTIN for EAN-13 The EAN-13 barcode will be expanded into 14-digit Global | No
Trade Item Number (GTIN).
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
Addon 2 / Addon 5 Decide whether to decode EAN-13/UPC-A with addons. No
(UPC-A) Convert to|The UPC-A barcode will be expanded into EAN-13, and the |Yes
EAN-13 next processing will follow the settings configured for
EAN-13.
» After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).
(UPC-A) Transmit | Decide whether to include the UPC-A check digit in the|Yes
Check Digit data being transmitted.
(UPC-A) Transmit | Decide whether to include the UPC-A System Number in|Yes
System Number the data being transmitted.
UPC-E Enable
Convert to UPC-A The UPC-E barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
> After conversion, the data follows UPC-A format and is
affected by UPC-A programming selections (e.g.
System Number, Check Digit).
Transmit Check Digit Decide whether to include the UPC-E check digit in the|Yes

data being transmitted.

78




Appendix Il

CCD/Laser Scan Engine

Transmit System | Decide whether to include the UPC-E System Number in|No
Number the data being transmitted.
Enable UPC-E1 Decide whether to decode both UPC-EO and UPC-E1|No
barcodes.
» By default, it decodes the UPC-EO barcodes only.
Enable UPC-E1 Triple|Decide whether to apply read redundancy to the UPC-E1|No
Check barcode.
» When applied, the same UPC-E1 barcode has to be
read three times to make a valid reading. This is
helpful when the barcode is defaced and requires more
attempts to read it successfully.
Addon 2 / Addon 5 Decide whether to decode UPC-E with addons. No
GS1 Formatting -
GS1-128 (EAN128) Decide whether to enable GS1 formatting for GS1-128. Disable
GS1 DataBar Family Decide whether to enable GS1 formatting for GS1 DataBar | Disable
Family.
Field Separator Specify the field separator. No
Application ID Mark Specify the application ID mark character. No

Note: UPC-E1 is supported on CCD/Laser scan engine for 8200/8600/8700 only.
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The tables below list reader settings as well as symbology settings for the Long Range
Laser (LR) or Extra Long Range Laser (ELR) scan engine.

READER SETTINGS TABLE

LR/ELR Engine

Description Default

Scan Mode

Laser mode

Continuous Mode

Non-stop scanning

» To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode

Non-stop scanning

» Capable of decoding the same barcode repeatedly

Alternate Mode

Press the scan trigger to start with scanning.

» The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.
» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.
Laser Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode

Press the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Time-out

3 sec.

0—~255 (second)

Set the maximum time for decoding to continue during a scan attempt.
It applies to the following scan modes only —

» Aiming mode

» Laser mode

» Auto Off mode

Aiming Duration

3 sec.

1~255 (second)

Set the maximum time for decoding to continue during a scan attempt.

> It applies to Aiming mode only.

Note: Long Range Laser scan engine are supported on 8300/8500 only.
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SYMBOLOGY SETTINGS TABLE (8300/8500)

LR/ELR Engine Description Default
Codabar Disable
Transmit Start/Stop | Decide whether to include the start/stop characters in the [No
Character data being transmitted.
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1-55)
Code 128 Enable
GS1-128 Enable
Field Separator | Decide whether to replace the field separator. If the|No
Replacement barcode contains Field Separator “Ox1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field
separator. Then if the barcode contains Field Separator
“Ox1D”, it will be changed to “;”.
ISBT 128 Enable
Industrial 25 (= Discrete 25) Enable
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1-55)
Interleaved 25 Enable
Convert to EAN-13 Convert a 14-character barcode into EAN-13 if the|No
following requirements are met:
» The barcode must have a leading 0 and a valid EAN-13
check digit.
Verify Check Digit Decide whether to verify the check digit. If desired, select|No
one of the algorithms below. If the check digit is incorrect,
the barcode will not be accepted.
> No
» USS algorithm
» OPCC algorithm
Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
Select Length » Any Length Any Length
> One or two fixed lengths
> Range (1-55)
Code 39 Enable
Convert to Code 32 Convert to Italian Pharmacode. No
Verify Check Digit Decide whether to verify the check digit. If the check digit|No

is incorrect, the barcode will not be accepted.
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Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
» "Verify Check Digit" must be enabled so the check digit
can be left out (= "Transmit Check Digit" disabled).
Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and |Disable
special characters.
Trioptic Code 39 Decide whether to decode Trioptic Code 39. Disable
» Trioptic Code 39 is a variant of Code 39 used in the
marking of computer tape cartridges. It always
contains six characters.
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1-55)
Code 93 Disable
Select Length Any Length Any Length
One or two fixed lengths
> Range (1-55)
MSI Disable

Verify Check Digit

If Two Check Digits option is selected, an additional
verification is required to ensure integrity. Select one of
the algorithms below. If the check digit is incorrect, the
barcode will not be accepted.

Check Digit
One Check Digit

Algorithm

Single Modulo 10

> Mod 10/Mod 11
» Mod 10/Mod 10

Two Check Digits

Single Modulo
10

Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1-55)
GS1 Databar -
GS1 Databar-14 GS1 DataBar-14 is short for GS1 DataBar Omnidirectional. | Enable
This group consists of (1) GS1 DataBar Omnidirectional,
(2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and
(4) GS1 DataBar Stacked Omnidirectional.
GS1 Databar Limited Enable
GS1 Databar Expanded | This group consists of (1) GS1 DataBar Expanded, and (2) [ Enable

GS1 DataBar Expanded Stacked.
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Convert GS1 Databar |"Convert to UPC/EAN" only applies to GS1 Databar-14 and [ No
to UPC/EAN GS1 Databar Limited barcodes not decoded as part of a
Composite barcode.
Convert to EAN-13
Strip the leading "010" from barcodes.
> "01" is the Application ID and must be followed by a
single zero (the first digit encoded)
Convert to UPC-A
Strip the leading "0100" from barcodes.
> "01" is the Application ID and must be followed by
two or more zeros (but not six zeros)
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the |No
next processing will follow the settings configured for
EAN-13.
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
EAN-13 Enable
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Bookland EAN The EAN-13 barcode starting with 978 will be converted to|No
(= Bookland ISBN-10) ISBN.
> Data starting with 979 is not considered Bookland in
this mode.
UPC-A Enable
Transmit Check Digit Decide whether to include the UPC-A check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-A preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
UPC-EO Enable
Transmit Check Digit Decide whether to include the UPC-EO check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-EO preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-EO barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
UPC-E1 Disable
Transmit Check Digit Decide whether to include the UPC-E1 check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-E1 preamble System |System
Number (and Country Code) in the data being transmitted. | Number
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Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-E1 barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
UCC Coupon Extended Code Disable

Read UPC-A barcodes starting with digit "5", EAN-13 barcodes starting with digits "99", and
UPC-A/GS1-128 Coupon Codes.

» UPC-A, EAN-13, and GS1-128 must be enabled first!

UPC/EAN Addon -—-

Addon 2 / Addon 5 Decide whether to decode EAN-8, EAN-13, UPC-EO, |Ignore...
UPC-E1, UPC-A with addons.

» Ignore Addons
» Decode Only With Addons
» Decode With Addons (= Auto-discriminate)

Code 11 Enable

Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.

» No verification
One Check Digit
Two Check Digits

One or two fixed lengths

4

4

Select Length » Any Length Any Length
4

» Range (1-55)

Note: Code 11 is supported on Long Range Laser scan engine for 8300 only.
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SYMBOLOGY SETTINGS TABLE (8700)

LR/ELR Engine Description Default
Codabar Enable

Transmit Start/Stop | Decide whether to include the start/stop characters in the [No

Character data being transmitted.
If "Transmit Start/Stop Characters" is desired, select one
set:
» abcd / abcd
» abcd / tn*e
» ABCD / ABCD
> ABCD / TN*E
Code 128 Enable
GS1-128 Enable

Transmit Code ID (for|Decide whether to include Code ID (“]C1”) in the data|No
GS1-128) being transmitted.

Field Separator | Decide whether to replace the field separator. If the|No

Replacement barcode contains Field Separator “Ox1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field

separator. Then if the barcode contains Field Separator
“Ox1D”, it will be changed to “;”.

ISBT 128 Enable

Industrial 25 (= Discrete 25) Enable

Start/Stop Selection This decides the readability of all 2 of 5 symbology|Industrial 25
variants. For example, flight tickets actually use an
Industrial 2 of 5 barcode but with Interleaved 2 of 5
start/stop pattern. In order to read this barcode, the
start/stop pattern selection parameter of Industrial 2 of 5
should be set to "Interleaved 25".

Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Select Length » One or two fixed lengths 1-127
» Range
Interleaved 25 Enable
Start/Stop Selection Refer to Industrial 25. Interleaved
25
Verify Check Digit Decide whether to verify the check digit. If the check digit|No

is incorrect, the barcode will not be accepted.

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
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Select Length » One or two fixed lengths 1-126
» Range
Matrix 25 Disable
Start/Stop Selection Refer to Industrial 25. Matrix 25
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
Select Length » One or two fixed lengths 1-127
» Range
Coop 25 Disable
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
French Pharmacode Disable
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
Italian Pharmacode (= Code 32) Disable
Transmit Check Digit Decide whether to include the check digit in the data being|Yes

transmitted.

Note: For French/Italian Pharmacode, “Transmit Start/Stop Character” is not provided in
Ul but it is controlled by the same setting of Code 39.

Code 39 Enable
Transmit Start/Stop | Decide whether to include the start/stop characters "*" in|[No
Character the data being transmitted.
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and |Disable
special characters.
Security Level » High High
» Normal
Code 93 Enable
MSI Disable
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Verify Check Digit

Select one of the three calculation formulas to verify the
check digit. If the check digit is incorrect, the barcode will
not be accepted.

» Single Modulo 10
» Double Modulo 10
» Modulo 11 & 10

Single Modulo
10

Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

» Last digit not transmitted

Both digits
transmitted

» Both digits transmitted
» Both digits not transmitted
Select Length » One or two fixed lengths 1-127
> Range
Plessey Disable
Convert to UK Plessey |When applied, each occurrence of the character "A" in the [No
barcode data will be replaced by the character "X".
Transmit Check Digit Decide whether to include the two check digits in the data|Yes
being transmitted.
Telepen Disable
Original Telepen | The original Telepen includes numeric characters. No
(Numeric)
AIM Telepen (Full | AIM Telepen (Full ASCII) includes all the alphanumeric and |Yes
ASCII) special characters.
GS1 Databar Disable

GS1 DataBar is short for GS1 DataBar Omnidirectional. This group consists of (1) GS1 DataBar
Omnidirectional, (2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and (4) GS1 DataBar
Stacked Omnidirectional.

Transmit Code ID Decide whether to include Code ID ("]e0™) will be included | Yes
in the data being transmitted.
Transmit Application | Decide whether to include the Application ID ("01") in the|Yes
ID data being transmitted.
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
GS1 Databar Limited Disable
Transmit Code ID Refer to GS1 Databar. Yes
Transmit Application | Refer to GS1 Databar. Yes
ID
Transmit Check Digit Refer to GS1 Databar. Yes
GS1 Databar Expanded Disable

This group consists of (1) GS1 DataBar Expanded, and (2) GS1 DataBar Expanded Stacked.

Transmit Code ID

Refer to GS1 Databar.

Yes

EAN-8

Enable
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Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the |No
next processing will follow the settings configured for
EAN-13.
> After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).
GTIN-13 Format Decide whether to convert using GTIN-13 format. No
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
Addon 2 / Addon 5 Decide whether to decode EAN-8 with addons. No
EAN-13 /7 UPC-A Enable
ISBN Conversion The EAN-13 barcode starting with 978 and 979 will be|No
converted to ISBN.
ISSN Conversion The EAN-13 barcode starting with 977 will be converted to | No
ISSN.
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
(UPC-A) Transmit | Decide whether to include the UPC-A System Number in|Yes
System Number the data being transmitted.
(UPC-A) Transmit | Decide whether to include the UPC-A check digit in the|Yes
Check Digit data being transmitted.
(UPC-A) Convert to|The UPC-A barcode will be expanded into EAN-13, and the |Yes
EAN-13 next processing will follow the settings configured for
EAN-13.
> After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).
GTIN for EAN-13 | The EAN-13 barcode will be expanded into 14-digit Global [ No
Trade Item Number (GTIN).
Addon 2 / Addon 5 Decide whether to decode EAN-13/UPC-A with addons. No
UPC-E Enable
Convert to UPC-A The UPC-E barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
> After conversion, the data follows UPC-A format and is
affected by UPC-A programming selections (e.g.
System Number, Check Digit).
Transmit System | Decide whether to include the UPC-E System Number in|No
Number the data being transmitted.
Transmit Check Digit Decide whether to include the UPC-E check digit in the|Yes
data being transmitted.
Enable UPC-E1 Decide whether to decode both UPC-EO and UPC-E1|No

barcodes.

» By default, it decodes the UPC-EO barcodes only.
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Enable UPC-E1 Triple|Decide whether to apply read redundancy to the UPC-E1|No
Check barcode.
» When applied, the same UPC-E1 barcode has to be
read three times to make a valid reading. This is
helpful when the barcode is defaced and requires more
attempts to read it successfully.
Addon 2 / Addon 5 Decide whether to decode UPC-E with addons. No
GS1 Formatting -
GS1-128 (EAN128) Decide whether to enable GS1 formatting for GS1-128. Disable
GS1 DataBar Family Decide whether to enable GS1 formatting for GS1 DataBar | Disable
Family.
Field Separator Specify the field separator. No
Application ID Mark Specify the application ID mark character. No
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The tables below list reader settings as well as symbology settings for the 2D scan
engine.

READER SETTINGS TABLE

2D Engjne Description Default
Scan Mode Laser mode
Continuous Mode Non-stop scanning

» To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode Non-stop scanning

» Capable of decoding the same barcode repeatedly

Alternate Mode Press the scan trigger to start with scanning.

» The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.

» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.

Laser Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode Press the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Decode lllumination |Decide whether to flash illumination on every barcode|On
capture to aid decoding.

» Turn On (Internal LED)
» Turn Off

Aiming Pattern Decide whether to project the aiming pattern during|On
barcode capture.

» Turn On
» Turn Off
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Time-out

3 sec.

0~255 (second)

Set the maximum time for decoding to continue during a scan attempt.
It applies to the following scan modes only —

» Aiming mode

» Laser mode

> Auto Off mode

Picklist Mode

Picklist mode enables the decoder to decode only barcodes|Disable
aligned under the center of the laser aiming pattern.

» Enable
> Disable

1D Inverse Decode

1D Inverse Decoder: Decode
regular 1D

» Decode regular 1D barcode only barcode only

» Decode inverse 1D barcode only

» Decode both regular and inverse

Aiming Duration (820

0/8600/8700 only) 3 sec.

1~255 (second)

Set the maximum time for decoding to continue during a scan attempt.

> It applies to Aiming mode only.

Read Redundancy

None

None

No redundancy means one successful decoding will make the reading valid

and induce the "READER Event".

One time or Two times

The higher the reading security is (that is, the more redundancy the user
selects), the slower the reading speed gets.

> If "Two Times" is selected, it will take a total of three consecutive
successful decodings of the same barcode to make the reading valid.

Mobile Display Mode

Decide whether to enable mobile phone display. Disable
» Enable
» Disable

Note: [Reader Settings] are supported on 2D scan engine for 8200/8400/8600/8700.
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SYMBOLOGY SETTINGS TABLE

1D SYMBOLOGIES
2D Engjne Description Default
Codabar Enable

Transmit Start/Stop | Decide whether to include the start/stop characters in the [No
Character data being transmitted.

Select Length » Any Length Any Length
> One or two fixed lengths
> Range (1-55)

Code 128 Enable
GS1-128 Enable
Field Separator | Decide whether to replace the field separator. If the|No
Replacement barcode contains Field Separator “Ox1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field

separator. Then if the barcode contains Field Separator
“0x1D”, it will be changed to “;”.

ISBT 128 Enable
Industrial 25 (= Discrete 25) Enable
Select Length » Any Length Any Length

> One or two fixed lengths
> Range (1-55)

Interleaved 25 Enable

Convert to EAN-13 Convert a 14-character barcode into EAN-13 if the|No
following requirements are met:

» The barcode must have a leading O and a valid EAN-13
check digit.

Verify Check Digit Decide whether to verify the check digit. If desired, select|No
one of the algorithms below. If the check digit is incorrect,
the barcode will not be accepted.

> No
> USS algorithm
» OPCC algorithm

Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.

Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1-55)
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Matrix 25 Disable
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
Select Length » Any Length Any Length
> One or two fixed lengths
> Range (1-55)
Chinese 25 Disable

Note: Matrix 25

and Chinese 25 are supported on 2D scan

engine for

8200/8400/8600/8700.
Code 39 Enable
Convert to Code 32 Convert to Italian Pharmacode. No
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
» "Verify Check Digit" must be enabled so the check digit
can be left out (= "Transmit Check Digit" disabled).
Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and|No
special characters.
Trioptic Code 39 Decide whether to decode Trioptic Code 39. No
> Trioptic Code 39 is a variant of Code 39 used in the
marking of computer tape cartridges. It always
contains six characters.
Select Length » Any Length Any Length
One or two fixed lengths
Range (1—55)
Code 93 Enable
Select Length » Any Length Any Length
One or two fixed lengths
Range (1—55)
MSI Disable

Verify Check Digit

If Two Check Digits option is selected, an additional
verification is required to ensure integrity. Select one of
the algorithms below. If the check digit is incorrect, the
barcode will not be accepted.

Single Modulo
10
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Check Digit
One Check Digit

Algorithm

Single Modulo 10

> Mod 10/Mod 11
» Mod 10/Mod 10

Two Check Digits

Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1-55)
GS1 Databar -
GS1 Databar GS1 DataBar-14 is short for GS1 DataBar Omnidirectional. | Enable
Omnidirectional This group consists of (1) GS1 DataBar Omnidirectional,
(2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and
(4) GS1 DataBar Stacked Omnidirectional.
GS1 Databar Limited Enable
GS1 Databar Expanded | This group consists of (1) GS1 DataBar Expanded, and (2) [ Enable
GS1 DataBar Expanded Stacked.
Covnert GS1 Databar |"Convert to UPC/EAN" only applies to GS1 Databar-14 and [ No
to UPC/EAN GS1 Databar Limited barcodes not decoded as part of a
Composite barcode.
Convert to EAN-13
Strip the leading "010" from barcodes.
> "01" is the Application ID and must be followed by a
single zero (the first digit encoded)
Convert to UPC-A
Strip the leading "0100" from barcodes.
> "01" is the Application ID and must be followed by
two or more zeros (but not six zeros)
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the |No
next processing will follow the settings configured for
EAN-13.
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
EAN-13 Enable
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Bookland EAN The EAN-13 barcode starting with 978 will be converted to | No

(= Bookland ISBN-10)

ISBN.

> Data starting with 979 is not considered Bookland in
this mode.
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Bookland ISBN-13

Barcode data, starting with either 978 or 979, will be
reported in 13-digit format to meet the 2007 ISBN-13
protocol.

No

Note: Bookland ISBN-13 is supported on 2D scan engine for 8200/8400/8600/8700.

UPC-A Enable
Transmit Check Digit Decide whether to include the UPC-A check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-A preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
UPC-EO Enable
Transmit Check Digit Decide whether to include the UPC-EO check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-EO preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-EO barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
UPC-E1 Disable
Transmit Check Digit Decide whether to include the UPC-E1 check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-E1 preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-E1 barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
UCC Coupon Extended Code Disable

Read UPC-A barcodes starting with digit "5", EAN-13 barcodes starting with digits "99", and

UPC-A/GS1-128 Coupon Codes.
> UPC-A, EAN-13, and GS1-128 must be enabled first!

UPC/EAN Addon

Addon 2 / Addon 5 Decide whether to decode EAN-8, EAN-13, UPC-EOQ, |Ignore...
UPC-E1, UPC-A with addons.
» Ignore Addons
» Decode Only With Addons
» Decode With Addons (= Auto-discriminate)
Code 11 Disable
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Verify Check Digit Decide whether to verify the check digit. If the check digit|No

is incorrect, the barcode will not be accepted.

» No verification

» One Check Digit

» Two Check Digits
Select Length » Any Length Any Length

> One or two fixed lengths

» Range (1-55)
Postal Codes -
US Postnet Enable
US Planet Enable
Transmit US Postal |US Postnet or US Planet must be enabled first! Enable
Check Digit
UK Postal Enable
Transmit UK Postal | UK Postal must be enabled first! Enable
Check Digit
Japan Postal Enable
Australian Postal Enable
Dutch Postal Enable
UPU FICS Postal Disable
USPS 4CB/One Code/ Disable

Intelligent Mail

Note: UPU FICS Postal and USPS 4CB/One Code/ Intelligent Mail are supported on 2D
scan engine for 8200/8400/8600/8700.

Composite Codes

Composite CC-C Disable

Composite CC-A/B Disable

Composite TLC-39 Disable

GS1-128 Emulation [ Transmit UCC/EAN Composite Code data as if it was|Disable

Mode for UCC/EAN |encoded in GS1-128 barcodes.

Composite Codes

UPC Composite Mode UPC barcodes can be "linked" with a 2D barcode during|UPC  Always
transmission as if they were one barcode. Linked

UPC Never Linked

Transmit UPC barcodes regardless of whether a 2D
barcode is detected.
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UPC Always Linked

Transmit UPC barcodes and the 2D portion. If the 2D
portion is not detected, the UPC barcode will not be
transmitted.

) CC-A/B or CC-C must be enabled!

Auto-discriminate UPC Composites

Transmit UPC barcodes as well as the 2D portion if

present.
GS1 Formatting -
GS1-128 (EAN128) Decide whether to enable GS1 formatting for GS1-128. Disable
GS1 DataBar Decide whether to enable GS1 formatting for GS1 DataBar | Disable
Omnidirectional Omnidirectional.

GS1 DataBar Limited Decide whether to enable GS1 formatting for GS1 DataBar | Disable

Limited.

GS1 DataBar Expanded | Decide whether to enable GS1 formatting for GS1 DataBar | Disable
Expanded.

Composite CC- A/B Decide whether to enable GS1 formatting for Composite | Disable
CC-A/B

Composite CC-C Decide whether to enable GS1 formatting for Composite | Disable
CC-C.

Field Separator Specify the field separator. No

Application ID Mark Specify the application ID mark character. No

Note: GS1-128 Emulation Mode is supported on 2D scan engine for 8200/8600/8700.
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2D Scan Engine

2D SYMBOLOGIES

2D Engjne Description Default

2D Symbologies -

PDF417 Enable
MicroPDF417 Enable

Data Matrix Enable

Data Matrix Inverse Decide whether to decode Data Matrix Inverse. Regular Only

Regular Only

Decode regular Data Matrix barcodes only.

Inverse Only

Decode inverse Data Matrix barcodes only.

Inverse Autodetect

Decode both regular and inverse Data Matrix barcodes.

Mirror Image (for Data
Matrix)

Decide whether to decode mirror image Data Matrix|Never

barcodes.

Never

Do not decode Data Matrix barcodes that are mirror
images.

Always

Decode only Data Matrix barcodes that are mirror
images.

Auto

Decode both mirrored and unmirrored Data Matrix
barcodes.

Maxicode Enable
QR Code Enable
QR Code Inverse Decide whether to decode QR Code Inverse. Regular Only

Regular Only

Decode regular QR Code only.

Inverse Only

Decode inverse QR Code only.

Inverse Autodetect

Decode both regular and inverse QR Code.
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MicroQR Enable
Aztec Enable
Aztec Inverse Decide whether to decode Aztec Inverse. Regular Only

Regular Only

Decode regular Aztec barcodes only.

Inverse Only

Decode inverse Aztec barcodes only.

Inverse Autodetect

Decode both regular and inverse Aztec barcodes.

Note: Data Matrix Mirror, MicroQR, Aztec, and 2D Inverse are supported on 2D scan
engine for 8200/8400/8600/8700.

2D Symbologies - Macro PDF

Macro PDF is a special feature for concatenating multiple PDF barcodes into one file, known as
Macro PDF417 or Macro MicroPDF417.

Transmit/Decode Mode

Decide how to handle Macro PDF decoding.

Buffer All Symbols / Transmit Macro PDF When Complete

Transmit all decoded data from an entire Macro PDF
sequence only when the entire sequence is scanned and
decoded. If the decoded data exceeds the limit of 50
symbols, no transmission because the entire sequence
was not scanned!

Transmit Any Symbol in Set / No Particular Order

Transmit data from each Macro PDF symbol as decoded,
regardless of the sequence.

Passthrough All Symbols

Transmit and decode all Macro PDF symbols and
perform no processing. In this mode, the host is
responsible for detecting and parsing the Macro PDF
sequences.

Passthrough
All Symbols

ESC Characters

When enabled, it uses the backslash "\" as an Escape
character for systems that can process transmissions
containing special data sequences. It will format special
data according to the Global Label Identifier (GLI)
protocol, which only affects the data portion of a Macro
PDF symbol transmission. The Control Header, if enabled,

is always sent with GLI formatting.

None
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Note: When printing barcodes, keep each Macro PDF sequence separate, as each has a
unique identifier. Do not mix barcodes from several Macro PDF sequences, even if

they encode the same data. When you scan Macro PDF sequences, scan the entire
Macro PDF sequence without interruption!
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